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1 Module 1: Introduction to Geospatial Information System 

(GIS) 
1.1 Theories and Concepts of GIS 

 

Learning Objectives: At the end of this module you will be able to;  

 

● Understand the theory and concepts of GIS  

● Get familiar with ARCGIS software along with geoprocessing tools and spatial analysis  

● Identify main open GIS data sources that can be used for Disaster Risk Management(DRM) 

● Baseline data analysis and information extraction in ARCGIS    

 

1.1.1 Introduction 

Geographic Information System (GIS) helps to manage spatial and non-spatial information in a very efficient 

way. Properly managed data and information helps in better territorial planning and decision making. In 

GIS, data about real-world objects is drawn quickly and can be displayed using the different attribute fields 

stored in GIS databases. A typical GIS data is shown in the Figure below.  

 
Source: Senseable City Laboratory, MIT 

1.1.2 Source and Nature of Spatial Data 

 

The sources for spatial data can be from different sources including Field observation/measurement, GPS 

based data collection, Remote sensing and software based derivations like map digitization. Now days 

Satellite based data acquisition is providing continues image products for almost all areas of the world at 

different spatial resolutions. The field based data collection also remain important in providing ground based 

accurate measurements which often helps to calibrate space based products.  
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1.1.3 GIS Data Models and Coordinate Geometry   

 

The nature of the spatial data can be of vector or raster format. Vector data formats are used to represent 

discrete type of data and often represented by point, line and/or polygon. Raster data types are used to 

represent continuous data types like rainfall, temperature, topography...etc. The smallest entity of a vector 

is a point whereas for raster it is a pixel. The type of data modeling depends on the nature of the data, the 

scale of the map, and our preference for the analysis that follows. However, it is good to remember that 

conversion of raster to vector or vise-versa is always possible although it might compromise the quality/form 

of the original data. For example, if you convert a raster to vector the edge may be generalized and may 

not follow the exact boundaries. It is highly recommended to avoid back and forth conversion of your data 

between vector and raster unless you are required to do so. It is also worth to remind you the many raster 

file formats which sometimes creates obstacles to data processing as all data formats are not compatible 

to the software’s we may choose to use.   
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Attributes shows characteristics of a feature; any additional information that are associated with each vector 

features such as land cover class or area or administrative division. So every field (column) in an attribute 

table refers to the attributes. Raster consists only of a cell value associated with that pixel.  

Coordinate systems: Any data that represent the location/position is called spatial data.  The most 

common ways of representing spatial data is through the use of X and Y or longitude and latitudes which 

are obtained through the system called coordinate system. There are two categories of coordinate systems 

and these are Geographic coordinate systems (uses degrees minutes and seconds) and projected 

coordinate systems (uses meter as a unit of measurement often with six/seven digit numbers).    

a) Geographic Coordinate Systems 

It uses Latitudes (0-90oN-S) and Longitudes (0-180oE-W)  and the Latitudes are measuring the distance 

from the equator( Y-dimension) and Longitudes are measuring distance from Greenwich (X dimension) 

either be positive on the north hemisphere or negative on the south Side of the equator are measured using 

degrees, minutes and seconds (° , ‘ , ’’). 

 

b) Projected Coordinate Systems  

This system by Mercator divides the globe in to 60 grids called zones and uses meter as a unit of 

measurement.  
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1.2 Introduction to ARCGIS 

1.2.1 Brief Introduction to Geospatial Technology 

Geospatial refers to a technology/advancement made in the areas of spatial data capture, processing, 

store, visualize, present and sharing using both hardware, software and methods. The advances made in 

space technology opened the way for spatial data capture which revolutionizes the geospatial world.  

Recent advances in space borne and airborne (including drones) technologies make the way for high 

resolution data capture in near real time. 

GIS helps to manage spatial and non-spatial information in a very efficient way. Properly managed data 

and information helps in better territorial planning and decision making. In a GIS, data about real-world 

objects is drawn quickly and can be displayed using the different attribute fields stored in GIS databases. 

ArcMap is one of the main components of ESRI’s ArcGIS Desktop software package, and it is used primarily 

to view, edit, create and analyze geospatial data. ArcMap allows the user to explore and analyze data from 

different datasets, symbolize features accordingly, and create maps. 

 

1.2.2 Learning Objectives  

 

By going through this exercise you will become familiarized with some basic tools and functionalities of 

ArcMap and you will be able to: 

➢ Recognize ArcMap interface and toolbars 

➢ Add, Manipulate data layers and attribute tables 

➢ Download baseline data. 

➢ Label features, create spatial bookmarks and save a map using relative path 

➢ Create an Area Of Interest known as AOI. 

➢ Clipping baseline data to AOI.  

➢  
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1.3  Glossary 

Geographic Information System (GIS): A system for capturing, storing, checking and 

displaying data related to positions on the Earth's surface. GIS can handle data as several 

layers, in two predominant data models. 

Raster consists of a matrix of cells (or pixels) organized into rows and columns (or a grid) where 

each cell contains a value representing information, such as temperature. Rasters are digital 

aerial photographs, imagery from satellites, digital pictures, or even scanned maps. 

Source: ESRI 

Vector consists of geographic features such as point, line and polygon. 

Source: ESRI 

Attributes shows characteristics of a feature; any additional information that are associated 

with each vector features such as land cover class or area or administrative division. So every 

field (column) in an attribute table refers to the attributes. Rasters consists only of a cell value 

associated with that pixel. 

Layer Files (layer_name.lyr) saves all of the symbolization (colors, symbols etc) and 

labelling that you have defined for that layer. Layer files do not contain the actual datasets. 

1.4 Basic Geoprocessing and Spatial Analysis  

1.4.1 Getting Familiar with ArcMap 

● Start ArcMap by double-clicking on the ArcMap icon on your desktop . If an icon is not 

present, you can use the Start Menu: Programs > ArcGIS > ArcMap. 



 

7 
 

● You can specify whether or not to start with a new empty map, a template or an existing map 

We will start this exercise by opening an empty map document: 

● Select Blank Map and click OK. 

 

1.4.2 ArcMap Interface and its main Elements 

Your ArcMap window should look similar to the one shown below. Do not worry if the interface displayed 

on your screen looks different. The toolbar will probably have a different layout but it may be easily 

customized according to your needs.  

 

1.4.3 Set Data Frame Properties  

From the Data Frame Properties dialog box, you can set the reference scale of your map, map units, 

coordinate system and assign a name to the data frame. 

● From the table of contents, right click on the data frame name “Layers” 

● Select Properties > General tab 

● In the Name section, type “ERI_data” 

● In the Units section, select Decimal Degrees for both Map and Display Units and click Apply 
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● Select the Coordinate System tab and notice that no projection is selected 

● Expand the Geographic Coordinate Systems > World > WGS 1984 

● Click Add to Favorites (so it will be easy to find next time) and click Apply >then OK 

 

Note: To display data correctly, each data frame uses a coordinate system which determines the map 

projection. The data frame coordinate system might be different from your layers coordinate system. 

ArcMap can project your data on the fly, but it can take longer to draw. 

When ArcMap is started with a new, empty map, the coordinate system for the default data frame is not 

defined. 

 

1.4.4 Add data into ArcMap 

● From the standard toolbar, click the Add Data button  

● Browse to: X:\ERI_data\Module1\Admin 
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● You might need to connect to the data folder for this exercise by clicking the Connect to Folder 

button in the Add Data dialog box  

● From Admin Folder, select ERI_adm1.shp and ERI_adm2.shp. You can select multiple files by 

pressing “Ctrl” key while selecting the files. 

 
The selected layers are added to the Table of Contents and displayed (if checked) in the Data View. Layers 

are displayed with random colors and can always be changed. 

1.4.5 Change Layer Color  

The layer’s symbol is the point, line or rectangle displayed below the layer name in the Table of Contents. 

To change the color or the size of a layer: 

● Double click on the symbol(s) below the layer name. 

● From the dialog box that appears, select your preferred color. 

● You can also edit an existing symbol and save it. 
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1.4.6 Arrange the Table of Content  

Data layers are drawn in the order they appear in the Table of Contents. Layers at the bottom are drawn 

first and layers at the top are drawn on the top of the map. If a layer on top is hiding a layer underneath you 

may not be able to see the lower layer. 

In the Table of Contents, you can move a layer up or down by dragging it to the desired position. 

1.4.7 Creating a Group Layer 

To improve the organization of the different data layers, you can create Group Layers to sort your data by 

category. A Group Layer behaves similar to other layers in the Table of Contents. To create a Group Layer: 

● Right click on the Data Frame > New Group Layer 

● Right click on the new group layer and select Properties 

● Enter “Administrative Boundaries” as Layer Name. You can change the name of the new group 

layer by single left click 

● Select “Show layer at all scales” and Click OK 

● Drag the displayed layers into the “Administrative Boundaries” Group Layer. 

1.4.8 Zoom and Pan 

 Use the ArcMap toolbar to zoom in, zoom out and pan over a region of interest within the data view. 

 

Notice that as you move the cursor around the map, the cursor position displayed at the bottom left of 

ArcMap window changes respectively. 
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1.4.9 Labeling Features  

Labels are text items on the map that are dynamically placed and whose text values are defined from one 

or more feature attributes. 

● Right click on one of the Admin layers > Properties and choose Labels tab 

● Check Label features in this layer 

● Select “Label all the features the same way” 

● Select label field that is the most appropriate. 

● Click Symbol… 

● Select from the Symbol Selector dialog box one of the predefined text labels 

● You can always modify your text labels by changing color, size and style. Click OK 

● Click Apply and OK 

 

● Right click on any layer, check or uncheck label features to have it on or off 
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1.4.10 Creating Spatial Bookmarks 

To save a specific extent of the map, you can use Spatial Bookmarks. Once saved, you can click the 

Bookmark button from ArcMap main menu bar, point to the saved bookmark and the map display will 

automatically zoom to that extent. 

● Zoom to one place of interest (choose any region(s) from ERI_adm2.shp) 

● From the main menu toolbar, click Bookmarks > Create 

● In the Spatial Bookmarks dialog box, type the name of the place you have chosen 

● Zoom to full extent  and then click Bookmarks > “placename” 

 

1.4.11 Create an Area of Interest (AOI) 

One of the key steps in managing and analysing geospatial data is to identify one or more areas of interest 

(AOI) which allows you to focus and limit your search over a specific area. 

● Click on Customize menu > Toolbars > Make sure Draw tool is checked 

● By using the drawing tool, Click on  and draw a new rectangle that covers your areas of 

interest (Click on the top-left vertex and drag to the vertex in bottom-right corner) 

● From the Drawing toolbar click Drawing > Convert Graphics to Features, activate “Automatically 

delete graphics after conversion”. Name the output layer as “AOI.shp” and save it on: 

X:\ERI_data\Module1\Output 

 

 
 

● Click Yes in the next dialog box to export the layer. 

● From the table of contents, double click on the icon of the layer you just created and change the 

layer style to hollow and outline red. 
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What is the purpose of creating an AOI layer? 

----------------------------------------------------------------------------------------------------------------------------- ---------------

-------------------------------------------------------------------------------------------------------------------- --------- 

1.4.12 Select Features 

This tool lets you select the features on which you want to perform certain operations (e.g. move, delete, 

edit, copy, etc.). You have multiple options for selecting features (i.e. by rectangle, circle, polygon, etc). 

 

NOTE: In order to make the layer of interest to be the only layer that could be selected, right click on the 

layer > Selection > Make this the only selectable layer. 

● From the ArcMap toolbar, click on the Select Features button  

● Hold down the shift key on your keyboard and select few features in any layer by clicking on 

them.  

● From the Table of Contents, right click on the feature of interest 

● Go to Selection > Create a Layer from Selected Features 

 

At this stage you cannot edit the selected features (you will learn later how to edit features later), but you 

can perform some basic operations such as zoom and pan, clear and switch selection and create new 

layers from selected features. 
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● Click on the Clear Selection button  

● Uncheck the Administrative Boundaries group layer 

● Right click on the layer created from selection 

● Click on Zoom to layer 

NB: The layer you have created is stored by ArcMap as a temporary file. If you want to create a new dataset 

from the selection you need to export the layer: 

● Right click on the layer > Data > Export Data… 

 

● In the dialog box, under the title, ‘Use the same coordinate system as’ choose “this layer’s 

source data” 

● Save the file in the following location: X:\ERI_data\Module1\Output 

● Name the feature class to export as “Practice_Selection” 

● Save as type “shapefile” and click save then click OK 

A prompt window will ask you if you want to add the exported data to the map as layer 

● Click Yes and explore the newly created dataset (zoom in, pan and identify features). 

When you are done, remove the two data layers that were created from the selected features 
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● Right click on the layer > Remove 

1.3 Check/activate the Administrative Boundaries group layer Right click > Zoom to layer   

1.4.14 Working with Attribute Tables 

In GIS, a feature on a map may be associated with a lot of information (attribute values) stored in a table. 

A layer’s attribute table contains a row (or record) for each feature and a column (or field) for each attribute 

or category (attribute field). 

To explore the attribute of a layer, open its attribute table to select and find features with a particular value. 

● Right click on “ERI_adm2” administrative layer 

● Click Open Attribute table 

The table opens, containing one record for each division. The FID field contains a unique identification 

number for every record (or every feature in the map). The intersection of a record and a field is a cell. A 

cell contains an attribute value. The total number of records stored in the table is displayed at the bottom 

of the attribute table. 

With the selection tool, select one or more records/features from either the Attribute Table or the Data View 

(from the map). 

 

Notice that when a record is highlighted in the table, its corresponding feature is highlighted on the map 

(and vice versa). 

● Right click on the selected record from the table 

● Click on Zoom to selected or Click on this icon  
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To sort attribute values stored in the table: 

● Right click on a field name and click Sort Ascending 

By clicking on the Options menu  on the top of the attribute table, you can perform more operations such 

as Find and Replace, Select by Attributes, Clear Selection, Switch Selection, Add Data, and so on. 

1.4.15 Advance Selection  

The Select by Attributes dialog box allows you to select features on a given layer using a SQL expression.  

● From the Main Menu Toolbar, click Selection > Select by Attributes 

The Select by Attributes dialog box appears 

● Select “ERI_adm2” under Layer 

● Select Create a new selection 

● Select the attribute field "Admin2" and 

● Double click on "Admin2", click “=” and click on 

Get Unique Values. 

A list with all the values will appear. Double click on an area 

of interest from the right. Scroll down to find your area of 

interest e.g. Afabet.  

In the dialog box below, the expression should appear as 

follows: "Admin2" = 'Afabet' (Choose a region of your 

interest, Ex: ‘Akurdet’). 

● Click Verify and then click OK 

● Click Apply 

● From the Main Menu toolbar, click Selection > Zoom to Selected Features. 

● Click Clear Selection and then Full Extent. 

NOTE: You can select more than one region using the IN function as shown below: 

"Admin2" IN( 'Adi Keyh' , 'Adi Quala' , 'Adi Tekeliezan' ) 

The Select by Location dialog box lets you select features based on their location relative to other features. 

You can use a variety of selection methods to select the point, line, or polygon features in one layer that 

are near, or overlap the features in the same or another layer.  
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1.4.16 Joining Tables 

Attribute tables contain predefined fields that hold data on geometry and the object ID. We can also add 

excel table into ArcGIS workspace and view the table. This table can be joined with existing layer or 

converted into a shapefile. 

In this exercise you will be joining the NDVI anomaly mean for Feb 2018 data to the level 2 (ERI_adm2) 

administration boundary polygons. 

● Add “ERI_adm2.shp” and “Mean_NDVI_anom_Feb2018.txt” data to ArcMap from this location; 

X:\ERI_data\Module1\Baseline_data 

Attribute tables for feature layers are automatically loaded when the layer is added to the map. Tables 

without associated features only show up on the Source tab of the ArcMap table of contents. 

 

Join the attributes of the “Mean_NDVI_anom_Feb2018” table to the Attribute table of “ERI_adm2”. 

● Right-click the layer or table you want to join (ERI_adm2), point to Joins and Relates > click 

Join. 

 

● Click the first drop-down arrow and click Join attributes from a table. 

● Click the second drop-down arrow and click the field name in the layer “Admin2” on which the 

join will be based. 

● Click the third drop-down arrow to choose the table to join to the layer 

“Mean_NDVI_anom_Feb2018.txt”. 
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● Click the fourth drop-down arrow and click the field in the table on which to base the join 

“Admin2”. 

● Click OK 

 

Open the attribute table of “Admin2”. The attributes of the table are appended to the layer's attribute table.  
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● To sort values in an attribute field right-click the selected field's heading and click Sort 

Ascending or Sort Descending. 

 

Which district has the highest mean of NDVI anomaly in Feb? ___________________ 

Which district has the least mean of NDVI anomaly in Feb? ____________________ 
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NOTE: You may want to remove the current join from “ERI_adm2” to do so, here is the procedure; 

● Right-click the layer containing a join you want to remove and point to Joins and Relates. 

● Point to Remove Join(s) and click the join you want to remove 

“Mean_NDVI_anom_Feb2018.txt”. 

 

1.5 Basic Geoprocessing and Spatial Analysis 

Rational: The main rationale for using geoprocessing tools and spatial analysis is to try to answer some 

spatial questions which are necessary to get more information out of your data to make an informed 

decision. 

Geoprocessing: refers to an activity or set of activities in GIS used to manipulate spatial data. A typical 

geoprocessing operation takes an input dataset, performs an operation on that dataset, and returns the 

result of the operation as an output dataset. All data preparation and manipulation can be called 

Geoprocessing. We will see some of the most important tools under this topic which really helps you answer 

spatial questions. There are hundreds of tools in ArcGIS to handle the various chores of day to day GIS 

activities. 

1.5.1 Spatial Analysis 

The rationale for spatial analysis science is to understand the spatial distribution, variation, interaction and 

relationships of features or phenomena. According to Carleton College definition spatial analysis is a set of 

techniques for analyzing spatial data. The results of the spatial analysis are dependent on the locations of 

the objects being analyzed. Software that implements spatial analysis techniques requires access to both 

the locations of objects and their attributes. The other description is from ESRI “Spatial analysis is how we 

understand our world—mapping where things are, how they relate, what it all means, and what actions to 

take. From the computational analysis of geographic patterns to finding optimum routes, site selection, and 

advanced predictive modeling, spatial analysis is at the very heart of Geographic Information System (GIS) 

technology.” 
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The goal of the spatial analysis is to answer spatial questions which might be related to location, pattern, 

change, scenarios and others. GIS software’s are designed to provide a state of the art tools to process 

data and answer such complex space based questions. 

There are hundreds of tools under the ARCGIS toolbox to help you carry out spatial analysis, however, it is 

very important to first design a methodology or a model which needs to be supported with scientific methods 

to reach a conclusion. 

1.5.2 Buffer Analysis 

Buffer analysis is one of the most important Geoprocessing tools that help to identify proximity of places 

from a reference layer. For instance, if you wish to identify road networks within 300 m  of rivers you can 

easily identify them. Let’s create a buffer of 300 m from a rivers and see how much road length is existing 

close to the river.  

● Open ArcMap and add the layer for Rivers from X:\ERI_data\Module1\Baseline folder  

● Click on Geoprocessing from the Menu Bar > then Click on Buffer 

 

● Under Input Features select “Major_rivers.shp”  

● Save Output Feature Class as ‘River_Buffer.shp’ at X:\ERI_data\Module1\Output\ 

● Linear Unit should be ‘300 meters’.  

● Click OK 
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● Zoom in to one river line to see the buffer area of 300m.  

 

What are the different applications this can be used? ____________________________________

What if we want different buffer distance like 1km, 5km, 10km to show from most to least areas at 

risk of flood hazard? 
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1.5.3 Multiple Ring Buffer  

Multiple Ring Buffer allows us to create multiple buffers at specified 

distances around the input features. The different levels of buffer 

distances can be used to define different elements at risk. 

 Click on ‘Search tool’ and type ‘Multiple Ring Buffer’.   

 Click on the ‘Multiple Ring Buffer (Analysis)’ tool. 

 Under Input Select “‘River_Buffer.shp” 

 Save the Output as “River_Mult_Buffer.shp” at  X:\ERI_data\Module1\Output\ 

 Under ‘Distances’ give the following three levels, 1, 5, and 10. Type each number once and click 

on the plus button (+).  

 Change the ‘Buffer Unit’ option to Kilometers. 

 Click OK 

 Now Zoom in to ‘River_Mult_Buffer.shp’ and see the different levels of Buffer distances.  
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1.5.4 Intersect  

This is an important geoprocessing tool to find the intersection between two or more layers. It has a practical 

application, for instance if you wish to calculate the length of roads existing in different countys (admin 2) 

of Djibouti, you can intersect roads layer with admin2 layer. Steps to carry out this is given below.  

Steps  

● Open ArcMap and add ‘ERI_roads.shp’ layer from X:\ERI_data\Module1\Baseline\ and 

‘ERI_Adm2.shp’ from X:\ERI_data\Module1\Admin\ folders respectively to Table of Contents.  

● Now go to Windows in ArcMap main menu and click on Search. Key in Intersect  and search 

and then open the ‘Intersect (analysis) tool’  

● Now give ‘ERI_roads.shp’ and ‘ERI_Adm2.shp’ as features to intersect 

● Save the Output feature class to X:\ERI_data\Module1\Output\ folder with the name 

Roads_Admin2.shp and click Ok. 

● Now you can open the attribute table of the Roads_Admin2.shp to see that the district names 

are attached to the roads attribute table. This means that you can also calculate the length of 

roads in each of the counties (admin 2).  

● Right click on ‘Admin2’ field in the attribute table of Roads_Admin2.shp and select ‘Summarize’ 

option.  

● Click on ‘Length’ field and select ‘sum’ and give an output name for the table as 

‘Road_sum_Adm2’ and select ‘Save as Type’ as ‘dbase’. Click OK for the option ‘Do you want to 

add result table to the map’.  

● Click on the table ‘Road_sum_Adm2’ in Table of contents and select open option.  

● Observe the table and try to understand the result.  
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1.5.5 Merge 

Merge is another important tool for combining two or more layers of the same feature types. This tool 

provides an opportunity to compile data of similar nature. Take for instance, you can merge ERI_roads.shp 

and Major_rivers.shp polyline layers, which can be used for assessing the combined transport network in 

Eritrea.  

Let’s merge the ERI_roads.shp and Major_rivers.shp layers in Eritrea for further analysis. 

● Add the ERI_roads.shp and Major_rivers.shp layers from X:\ERI_data\Module1\Baseline\ 

● Search for a tool Merge and open. Set the ERI_roads.shp and Major_rivers.shp layers  as 

inputs layers  

● Save the Output feature class to X:\ERI_data\Module1\Output\ folder with the name 

Road_River_network.shp and click OK. 

● If you open the layer, you will notice that the two layers and their attribute tables are combined. 

 

1.5.6 Saving Your Workspace 

After you finish working on a map, you can save it and exit ArcMap. ArcMap saves your map as a project 

document (.mxd). The Home folder available in the Catalog window is used by default in ArcMap to save 
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results, store new datasets, and to access file-based information. In addition, each map document has a 

default geodatabase, which is the home location for the spatial content of your map. This location is used 

for adding datasets and for saving resulting datasets created by various editing and geoprocessing 

operations. 

If you haven't saved the map project before and you want to save it into a desired folder location: 

● Click File > Save As. 

● Enter the name “Module1_Intro_ArcMap.mxd”  and save it on: X:\ERI_data\Module1\Output\  

 

   

1.6 Open GIS data Sources 

In the aftermath of a disaster it is very important to collect and review disaster related information from 

media reports, OCHA situation reports, reports from government and local authorities. This would enable 

you to get an understanding about the type and magnitude of the disaster event which is very useful before 

doing any kind of geospatial analysis. When a first review of available disaster- related information is 

completed, you can start searching and gathering relevant geo-data (i.e. pre and post disaster satellite 

imagery and GIS baseline data) to be used for GIS analysis and mapping. 

1.6.1 Baseline Geospatial Data for Disaster Risk Assessment 

This section presents a list of free and commercial spatial available for download. Explore and download 

some GIS and EO data by browsing different geospatial data portals, which provide access to useful data 

sets for emergency response mapping. 

Web Portal Web Link Data Description Data Type 

ICPAC-Geoportal http://geoportal.icpac.net/ Free regional data Vector/Rast

er 
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ArcGIS Online http://www.esri.com/software/arcgis/arcgisonline Free online 

imagery, relief, 

topography, road 

networks 

Web map, 

not editable, 

only visual 

Giovanni http://giovanni.gsfc.nasa.gov/giovanni/ Free Precipitation 

data (TRMM, GPM) 

TIFF 

MODIS Rapid 

Response System 

http://earthdata.nasa.gov/lance/rapid-response Free imagery from 

the MODIS sensor 

Multiband 

raster 

Digital Globe http://www.digitalglobe.com Commercial 

satellite very high 

resolution imagery 

Preview 

imagery can 

be 

downloaded 

USGS earthexplorer http://earthexplorer.usgs.gov Free Landsat, 

ASTER, SRTM, 

MODIS 

Raster 

OpenStreetMap 

OSM 

http://extract.bbbike.org/ Free Baseline data Vector 

Humanitarian Data 

Exchange 

https://data.hdx.rwlabs.org/ Free Baseline data Vector/Rast

er 

Sentinel Scientific 

Hub 

https://scihub.copernicus.eu/dhus Free RADAR and 

high resolution 

OPTICAL data 

Raster 

WorldPop http://www.worldpop.org.uk/ Free Population 

data 

Raster 

Flood monitoring portal  

https://realearth.ssec.wisc.edu/?products=RIVER-FLDglobal-
composite.75&center=10,0&zoom=3&basemap=satellite&labels=-&timestep=1d  

 

http://www.esri.com/software/arcgis/arcgisonline
http://giovanni.gsfc.nasa.gov/giovanni/
http://earthdata.nasa.gov/lance/rapid-response
http://www.digitalglobe.com/
http://earthexplorer.usgs.gov/
http://extract.bbbike.org/
https://data.hdx.rwlabs.org/
https://scihub.copernicus.eu/dhus
http://www.worldpop.org.uk/
https://realearth.ssec.wisc.edu/?products=RIVER-FLDglobal-composite.75&center=10,0&zoom=3&basemap=satellite&labels=-&timestep=1d
https://realearth.ssec.wisc.edu/?products=RIVER-FLDglobal-composite.75&center=10,0&zoom=3&basemap=satellite&labels=-&timestep=1d
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2 Module 2: Vegetation and Land Cover/Land Use 

Monitoring 
In this module we will cover vegetation and land cover monitoring using satellite data and remote sensing 

technologies. One of the most important opportunities presented by advancements in remote sensing 

through earth observation satellites is the ability to monitor phenomenon on or around the Earth’s surface 

at near-real time over the entire planet. Earth observation satellites have enabled large scale monitoring of 

remote inaccessible regions such as the Amazon or the icebergs at the poles.  

Vegetation indices derived from Earth observation satellites are important for a wide range of applications 

such as vegetation monitoring, drought studies, agricultural activities, climate and hydrologic modeling. 

Vegetation monitoring plays an important role in drought early warning systems, which help to anticipate 

the risk of food crises at local and global scale. Land Cover analysis is important in monitoring changes on 

the land which is useful in identifying deforestation activities, forest degradation, human encroachment into 

protected areas and so on.  

This module is divided into two sections: 1) Vegetation Monitoring and 2) Land Cover/Use monitoring. We 

will use the eStation software to monitor vegetation variables over time and over space in Eritrea. Using 

maps and graphs we will identify trends and patterns over time and compare current conditions to past 

conditions. In the second section of this module we will use IMPACT toolbox to perform land cover/use 

mapping and land cover change analysis to understand how the land is changing and thus the impact of 

such changes. IMPACT offers a toolbox for high resolution satellite imagery processing, classification and 

statistics generation.  

 Vegetation Monitoring 

 Vegetation Indices 

 Introduction to the eStation  

 Rainfall and NDVI maps 

 Rainfall and NDVI Anomaly maps 

 Land Use Land Cover Analysis 

2.1 Vegetation Monitoring 

Learning Objectives: By the end of this module you will be able to: 

● Monitor vegetation condition using satellite derived data (Earth Observation data) 

● Create and interpret maps and graphs of vegetation and rainfall conditions from EO data 

● Understand how to analyze vegetation condition using the eStation system. 

● Identify geographically areas of dry spells and vegetation stress at specific times 

2.1.1 Vegetation Indices 

Vegetation indices are derived from multispectral or hyperspectral remotely sensed images to enhance the 

properties of vegetation thus helping to distinguish vegetation from the other features in the image. A 

Vegetation Index is a single unitless value calculated by combining different spectral bands of a satellite 

image using various algorithms to accentuate vegetation signal. Depending on the transformation algorithm 

and the spectral bands used, the resulting vegetation index will highlight different aspects of the vegetation 

in the image such as percentage of vegetation cover, amount of chlorophyll content, leaf area index and 

green biomass among others. Vegetation Indices (VI) exploit the differences in the amount of differing 

reflected radiation from plants across the electromagnetic spectrum. The reflection of radiation by 
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vegetation shows low values in the blue and red band, slightly higher values in the green band, very high 

values in the near infrared band, and low to high values in the shortwave infrared bands (depending on the 

wavelength). Very characteristic for the vegetation spectrum is the steep increase of reflectance from red 

to near infrared, the so called “red edge”. 

 

One of the most common vegetation indices is Normalized Difference Vegetation Index (NDVI) that exploits 

the “red edge”. NDVI is calculated from NIR and RED reflectance and NDWI from NIR and SWIR.  

𝑁𝐷𝑉𝐼 =
(𝑁𝐼𝑅 − 𝑅𝐸𝐷)

𝑁𝐼𝑅 + 𝑅𝐸𝐷
 

 

𝑁𝐷𝑊𝐼 =
𝑁𝐼𝑅 − 𝑆𝑊𝐼𝑅

𝑁𝐼𝑅 + 𝑆𝑊𝐼𝑅
 

 

Other common vegetation indicators include: Enhanced Vegetation Index (EVI), Soil Adjusted Vegetation 

Index (SAVI), and Vegetation Condition Index (VCI). 

 

 



 

32 
 

The eStation provides access to several vegetation indices among other products such as rainfall 

estimates, fire and temperature EO data. Vegetation Indices available on the eStation inlcude: 

● NDVI – Normalised Difference Vegetation Index, is an index of plant “greenness” or photosynthetic 

activity.  

● LAI – Leaf Area Index is the total one‐sided area of leaf tissue per unit ground surface area. LAI 

directly quantifies canopy structure, and can be used to predict primary productivity and crop growth 

● Fcover - Fraction of green Vegetation Cover, corresponds to the fraction of ground covered by 

green vegetation. It quantifies the spatial extent of the vegetation. It is also a good indicator of the 

start of the growing season, and the time series can be used for year to year comparison of 

vegetation status for applications in agriculture and forestry among others.  

● fAPAR - Fraction of Absorbed Photosynthetically Active Radiation. The FAPAR quantifies the 

fraction of the solar radiation absorbed by live leaves for the photosynthesis activity. Then, it refers 

only to the green and alive elements of the canopy. 

● VCI - The Vegetation Condition Index (VCI) compares the current NDVI to the range of values 

observed in the same period in previous years. The VCI is expressed in % and gives an idea where 

the observed value is situated between the extreme values (minimum and maximum) in the 

previous years. Lower and higher values indicate bad and good vegetation state conditions, 

respectively. 

● DMP – Dry matter Productivity (DMP) represents the overall growth rate or dry biomass increase 

of the vegetation and is directly related to ecosystem Net Primary Productivity (NPP), however with 

units customized for agro-statistical purposes (kg/ha/day). 

 

Vegetation Indices are also available for download from the Copernicus website:  

https://land.copernicus.eu/global/themes/vegetation 

Introduction to eStation 2.0 

By the end of this section you will be able to: 

● Install and set-up eStation on windows computer 

● Get familiar with the eStation user interface 

● Create rainfall, vegetation and fire maps on the eStation and download these maps for integration 

into reports or presentations 

● Create rainfall, vegetation and fire analysis graphs on the eStation and download graphs in .PNG 

picture format for integration into reports or presentations.  

● Download rainfall, vegetation and/or fire data of an area of interest in excel format for further 

analysis 

● Interpret rainfall and vegetation maps to monitor the environment 

 

The eStation 2.0 is an Earth Observation processing system developed by the Joint Research Center 

(JRC) since the year 2009. The eStation 2.0 is designed to automatically deal with acquisition, processing, 

visualization and analysis of key environmental parameters derived from remotely sensed data. The 

https://land.copernicus.eu/global/themes/vegetation
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measurements are, among others, obtained from the SPOT/PROBAV, SEVIRI/MSG, TERRA-

AQUA/MODIS and Copernicus Sentinel 2 and 3 Earth Observation satellites. 

 

The eStation has been distributed to the Regional and National Centers in all sub-Saharan African countries 

involved in the MESA project and is being further developed and customized for the beneficiaries of the 

GMES & Africa support program.  

In addition to the MESA stations, eStation is now available in two other formats: 

● eStation for Windows – that can be installed on any computer running Windows Operating System  

● Online eStation available at https://estation.jrc.ec.europa.eu/eStation2/ 

 

In this training we will use the windows version. The eStation 2.0 for Windows Operating System can be 

downloaded at https://estation.jrc.ec.europa.eu/webclients. The installation manual is also available on the 

same page.  

To proceed with the exercises on this workshop you need the following 

i) eStationSetup-Full-2.1.2.exe  

ii) eStation 2.0 Installation Manual Windows 

iii) Earth Observation data available on the disk distributed during the workshop. 

Downloading the eStation 2.0 

eStation 2.0 can be downloaded from the JRC website at https://estation.jrc.ec.europa.eu/webclients. On 

this website page, there are two options of the software: i) full version with vector layers ii) light version 

without vector. Vector layers are shapefiles (GIS files) of various boundaries such as country, province, 

district, protected area etc.  

● Download one of the versions it is recommended to download the full version 

● Download the installation manual 

Installing the eStation 2.0 

Copy the eStationSetup-Full-2.1.2.exe onto your computer 

Follow the instructions in the installation manual (also available as an Annex in this document) 

2.1.2 Launching eStation 2.0 

To start the eStation 2.0 after a successful installation. 

● Go to Start > All Programs > eStation2 >  

● Click StartRestart eStation Services to start the eStation services  

https://estation.jrc.ec.europa.eu/eStation2/
https://estation.jrc.ec.europa.eu/webclients
https://estation.jrc.ec.europa.eu/webclients
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A screen with command prompt as shown on the upper right will appear 

● Click Yes on the pop-up screen asking if you would like to allow the program to make changes to 

your computer, the second command prompt window on the lower right will appear, it will stop and 

restart Apache. 

● Open a browser (firefox or chrome) and in the url bar type localhost, this will start the eStation 

interface like below 

 

 

The eStation 2.0 interface on localhost has 7 tabs as below: 
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● Dashboard: Presents the overall status of the MESA Station, and allows user to control all the 

enabled services. 

● Acquisition: To view and control the status of the services for retrieving and ingesting the EO data. 

● Processing: to start and stop the processing of new products, e.g. to control the ‘Processing’ 

Service. 

● Data Management: lists available data sets, both those acquired and processed by the eStation 

2, allows user to generate list of missing data and to download the missing data to ensure 

completeness of the time series. 

● Analysis: to perform the data analysis and generate maps and graphs for bulletins/reports.  

● System: to control the application settings (Thema region, log level, and working directories paths), 

and to generate system reports. 

● Help: allows the user to download the help files in pdf and to access reference web sites. Currently 

four pdf files are available: i) User Manual ii) Administration Manual iii) Installation Manual iv) 

Product report that lists and describes all the data available in the MESA station. 

2.1.3 Set directory path of the data 

Important: Before starting work on the eStation for windows version you have to set the path to the folder 

containing the data. This is done on the Systems tab 

● Go to Systems tab >  

● Change the path of Data to reflect the path to where you copied you data. NB: It is recommended 

to keep the directory name as “data” and to maintain the directory structure of the data.  

● Then Click Save to save the new settings 
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2.1.3.1 Register and Login 

It is recommended to register and then to work while logged in. These allows you to save your work as a 

workspace, this way if you stop working on the eStation you can continue from where you left. 

● Click Register 

● Enter full name, username and password and click Submit 

● Once you have successfully registered, use your username and password to Login 

Note: It is possible to create maps and graphs without logging in however, once you shut down the eStation 

you will not be able to save your work 

2.1.4 Create maps and graphs of vegetation and rainfall  

The eStation 2.0 has 7 tabs. To visualize the data as maps or graphs, we use the Analysis tab. 

Overview of Analysis tab 
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2.1.5 Create NDVI Maps 

1. Click New Map 

2. Click Products: this displays the list of data available on the eStation grouped by categories i.e. 

vegetation, rainfall, fire and miscellaneous NB: if the product list is empty, it means the path to the 

data is not set. Check under Systems tab that the directory path for Data is correct i.e. points to 

the location of the data and that the top directory is named data/ 

3. Click on Vegetation to expand the list and show the list of available vegetation products; DMP, 

FCOVER, LAI, NDVI and fAPAR 

 

 

4. Select NDVI  

5. Select a Mapset on the right this will open the list of sub-products 

6. Select 10 Day ndvi 

7. Select the legend to apply, go with the default ndvi value JRC 

8. Click Add Map 
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The NDVI map will display in the map area as below 
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2.1.5.1 Download map as picture image 

eStation 2.0 allows users to download the maps as .png to be used in reports or presentations. 

To download the NDVI map as a .png: 

● Click on the button written PNG on the top left of the map viewer labelled as “save map as PNG” 

● Select the folder to save the png. In this case save in flash_disk:/eStation/outputs/ 

● It’s optional to change the name of the file, it is recommended to use the default file name 

especially if you will be saving several images as the default naming takes into account the 

region, data type and date. 

● Click Save 

Navigate to the folder where you just saved the image. You should find the file: 

10 Day NDVI sv2-pv2.2 SPOTV-Africa-1km 20190921.png 
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2.1.5.2 Add Title and Logo to Map 

To make the map more understandable to users you can add a Title, relevant logos and a disclaimer. 

● Click the add title button  on the top right of the map viewer as shown on the figure  

 

● To move the position of either of the three items; title, logo or disclaimer Click and Drag to new 

position 

● To edit any of the three items, double click on one at a time to enter edit mode  

 

 

2.1.5.3 Add Country Boundary 

eStation 2.0 comes pre-loaded with several boundary data referred to as Layers. The Layers are divided 

into categories i) Borders Layer, ii) Marine Layers and iii) Other Layers.  
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The Administrative boundaries layers are from FAO-GAUL (Global Administrative Units Level) dataset. 

The first level corresponds to a region i.e. East, West, North Africa etc. Level-0 data corresponds to 

Country boundaries, Level -1 corresponds to Province or Region in a Country, and Level-2 corresponds 

to smaller administrative units like Districts. For Eritrea, Level-1 correspond to Zoba boundaries and 

Level-2 corresponds to sub-Zoba boundaries. 

To add any boundary as an overlay on the map: 

1. Click on the Open a Vector Layer icon  on the top left of the map viewer window 

2. Select Border Layers > AU-Region: EAST > Click ICPAC level-0 to select it and add the boundary 

of ICPAC to the map 

 

 

The map shows data for either the whole of Africa or ICPAC region based on the Mapset  selected when 

creating the map. It is possible to zoom to a specific region (polygon) and through the outmask process 

mask out the areas that are not of interest. To show only the map of Eritrea 

3. On the map, click anywhere within Eritrea to select the boundary of Eritrea 

4. To show only data for Eritrea, we will use the Outmask button. Click the Outmask button on 

the top right of the map-viewer window  
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5. Click the Zoom in button to zoom into the map 

6. To Center the map over Eritrea, click inside Eritrea hold and move the map to the center. 

 

By default the map displays the latest data available, in this case the latest NDVI data available is of 

the last dekad of September 2019 (21-09-2019). eStation 2.0 allows you to navigate the available 

time series using the time bar at the bottom of the map viewer.  
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7. To display the map of a different date use the “time bar” at the bottom of the map viewer; Placing 

the cursor on the green bars, a pop up displays the date, clicking on the green bar will change the 

map to display the NDVI of the selected date. 

 

 

 

Exercise 1:  

● Create monthly NDVI maps of Eritrea for the past 12 months to show the evolution of NDVI over 

time. Organise these maps into a powerpoint slide. 

● Following the above steps, create monthly rainfall estimate maps of Eritrea for the past 12 

months. Use Chirps rainfall data, organise the maps into a powerpoint slide to show evolution.  

● Create a monthly rainfall map for Debub Zoba for September 2018. The map should include a 

title, and relevant set of logos, sub-Zoba boundaries 

2.1.6 Create Graphs 

Graphs are important in understanding trends over time. eStation 2.0 provides 4 different types of 

graphs.  

eStation 2.0 creates graphs by aggregating pixel values over a region i.e. on a polygon.  Below are the 

four types of graphs available in eStation 2.0.  

● Profile 

● Cumulative 

● Ranking 

● Matrix 

There are five steps for creating any of the above graphs 
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Step 1: Select the area/region to perform the analysis 

Step 2: Select the type of graph (profile, cumulative, ranking, matrix)  

Step 3: Select the data products you want to analyse 

Step 4: Select the time period  

Step 5: Generate the time series graph 

 

2.1.7 Create a rainfall and NDVI graph (profile graph)  

Profile graphs are temporal graphs showing how rainfall or NDVI behave during a specific season or over 

time. Graphs combining rainfall and NDVI are particularly useful for early warning purposes. Combined 

graphs show possible stress situations and indicate whether evidence from both independent data 

sources regarding such situations converges. To create a graph: 

● Click NEW GRAPH button to open the graph window 

● Select the area of interest in this case Debub Zoba; to select the place you map over Debub Zoba 

and click to select 

● The selected region is highlighted in red on the map and shown on the graph window as below 
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● Select rainfall data (Chirps 10 day RFE) and NDVI data (10 day filtered NDVI) from the product 

list (The order of selecting the products affects the position of the graph elements for example if 

you select NDVI first the NDVI line graph will appear behind the bar) 

● Select the time as 2018 

● Click Get Timeseries to generate the graph 
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Overview of the graph viewer interface 

 

2.1.7.1 Edit Graph Properties 

To edit the graph properties for example change the color of the bars/lines, the minimum and maximum 

values of the Y-axis, use the Edit graph properties. 

● Click the Edit graph properties  on the top left of the graph viewer. 

 

● On the graph the two axes for NDVI and Rainfall both appear on the left side. To move one of the 

axes to the right, edit the property yAxe Opposite = false change it to True 

● Edit the minimum and maximum value of NDVI axes by changing the following properties in the 

graph properties editor 

o yAxe 1 min = 0 
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o yAxe 1 max = 0.5 

● Save the graph as .png in the folder output directory 

 

2.1.7.2 Download data for a region in tabular format (excel format) 

Once you have created the graph it is possible to download the data in excel format  

● Click the Download Time Series  on the top left of the graph viewer 

● Select the folder to save the tabular data  

● Click Save 

● The file is saved in .xls, open the file using excel 

● The file will contain a column for the date and columns for the selected data i.e. for the graph 

above it will contain date, Chirp rainfall and NDVI. 
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2.1.8 Create a cumulative graph 

The Cumulative Graph computes for the selected region the cumulative amount of rainfall (or NDVI) over 

time 

 

2.1.9 Create a ranking graph of rainfall 

The ranking graph calculates the total of the indicator (rainfall, ndvi, dmp) per year for the years selected 

and ranks years from the least to the highest as below. 
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2.1.10 Matrix Graph 

The matrix graph shows spatial visual representation of an indicator over selected years. The graph is 

useful in identifying patterns over time.  

 

 

 

Exercise 2: 

● Create a profile graph of Rainfall and DMP over Anseba for the year 2018  

o Identify the rainy season from the graph 

● Create a cumulative graph of DMP over Anseba Zoba for the year 2016. 
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● Create a Ranking graph of Rainfall over Anseba Zoba for the period 2014 – 2018 

o Identify the  year with the least amount of rainfall and the year with most amount of 

rainfall 

2.1.11 Rainfall and Vegetation Anomalies 

An Anomaly is a deviation from normal behavior. Rainfall and NDVI anomalies can be represented in 

maps, which identify how and where rainfall and vegetation development are different from normal. The 

current conditions can be below or above normal conditions:  

● Below-normal conditions relate to drought (water stress) conditions. These may have 

implications for crop yields and pasture availability, potentially affecting human lives and 

livelihoods. 

● Above-normal conditions could imply good vegetation development, but in the case of rainfall 

could also relate to problems like flooding. Therefore it is good to look at more indicators, i.e. not 

only at rainfall. Rainfall is a necessary condition for crop development, while vegetation indices 

observe actual vegetation growth. 

The following maps show the rainfall anomaly maps of the same period (May) in 2018 and in 2019, from 

the maps, the rainfall estimates in May 2019 were below normal for most of the Eastern Africa region 

while for the same period the previous year (May 2018), the rainfall estimates were above-normal for 

most of the region 

 

The MESA stations contains the following statistics for the various data i.e. for vegetation, rainfall and 

temperature. 

● Long term average (LTA):- for each pixel multi-years average of the available time series 

● Long term minimum:- for each pixel multi-years minimum value of the available time series   
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● Long term maximum:- for each pixel multi-years maximum value of the available time series data 

The station has anomalies computed as relative and absolute differences for each data i.e. vegetation, 

rainfall, temperature. The anomalies are available at two timescales; dekadal (10ddiff), monthly(1mondiff). 

● Absolute:- simple difference between current and long term average 

o dekad anomaly 10ddiff= (10d – 10davg) and  

o monthly anomaly 1mondiff=(1monndvi – 1monavg) 

● Relative:- the difference between current and long term average is expressed as a percentage of 

the long term average 

o dekad anomaly in percentage = (10d-10davg)/10davg 

o monthly anomaly 1mondiff=(1monndvi – 1monavg)/1monavg 

In this section we will use NDVI and Rainfall anomaly maps and graphs to identify geographic locations of 

dry spells and vegetation stress at specific times during the crop season.  

2.1.12 Create Rainfall and NDVI anomaly map over Eritrea 

The process to create an anomaly map is similar to the process explained above except for selecting the 

right anomaly data. 

To create rainfall anomaly map: 

● Click New Map 

● Click PRODUCTS > Rainfall > Chirps RFE >  

● Select 1 Mon Diff to LTA 

● Outmask to show only Eritrea 

● Add the following Vector Layers; Country Boundary and Zoba boundary 

The maps below show the monthly rainfall for 1st dekad of May 2019 (left) and the monthly rainfall 

anomaly map of the same period 1st dekad of May 2019 (right). 

NB: While there was rainfall recorded for May 2019, compared to the normal, for most of the areas with 

rainfall the rainfall recorded was between 50 -100m below normal. However, for 1st Dekad of January 

2019, the amount of rainfall received is similar to the normal and therefore the anomaly map does not 

show any areas either below or above the normal. 
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To create NDVI anomaly maps 

● Click New Map 

● Click PRODUCTS > Vegetation > NDVI >  

● Select 1 Mon Diff to LTA 

● Outmask to show only Eritrea 

● Add the following Vector Layers; Country Boundary and Zoba boundary 

2.1.13 Create graphs comparing current vs Long Term Statistics 

To understand how a certain period (say current year) compares to historic periods, we create profile 

graphs including the long term statistics. The graph will include the long term average,  

To create comparison graphs: 

● Click New Graph 

● Select the region as  Debub Zoba 

● Select type of graph as Profile graph 

● Select the following data (in the specific order) 

o 10d NDVI-Min 

o 10d NDVI-LTA 

o 10d NDVI-Max 

o 10d NDVI-10-Day filtered 

● Select Period as Sep 2018 to Sep 2019 

● Click Generate graph 
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The NDVI graph above shows above-normal vegetation starting from August 2018 to February 2019, 

while NDVI was slightly below normal at the start of 2018.  

 

Exercise 3: 

● Create monthly rainfall anomaly maps for Eritrea for 2019. Use PowerPoint slide to organize the 

maps showing evolution over time 

● Create a ranking graph for rainfall anomaly for Eritrea and for Debub Zoba. Identify the year that 

received the least amount of rainfall compared to the normal and the year that received the most 

amount of rainfall compared to the normal. 

2.2 Impact Tool for land cover Analysis (Landsat and sentinel 2 data) 

2.2.1 Introduction  

IMPACT toolbox was designed for analyzing and assessing forest degradation using 

satellite imagery. Processing satellite imagery requires many technical operations: 

IMPACT toolbox proposes a series of module simplifying those tasks, as many 

intermediate steps are wrapped in unique functions. 

Installing IMPACT and Review of IMPACT Functions 

 Installing the IMPACT software 

o Downloading and launching Impact 

Impact runs on Microsoft Windows 64bit (Xp, Vista,Win7,Win8,Win10). You can 

download the self-extracting pakage (.exe) or the compressed one (.zip) from our server 

http://forobs.jrc.ec.europa.eu/products/software/: save it on your disk and run it.  
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Choose a place on your hard drive to extract and save the software. Once the extraction 

is done, you will find a directory named IMPACT (default), which has the following 

directories inside:  

- DATA folder: contains user’s vector and raster data (for further details see the "getting 

data section" below);  

- GUI folder: contains the graphical user interface, dependencies and map editing 

functions;  

- LIBS folder: contains the engine and other software such as Apache, Python, GDAL, 

Openlayers, Mapserver, GeoExt, Javascript and HTML;  

- TOOLS folder: contains a dedicated folder for each processing module or external 

library/package used within the tool such as a portable version of Firefox under 

“Browser”, python scripts for image classification, segmentation, clipping etc;  

- START_Impact.bat: Impact launching command.  

To start Impact, double click on "START_Impact.bat". You have two windows: a shell 

window (a black windows showing only text) and the Impact graphic user interface, 

showing a map, and different icons. Note that the shell windows should not be close, 

else Impact would not work properly.  

To close Impact, close the shell windows. If you accidently close the Graphic User 

Interface, close the shell window and then restart Impact tool.  

 

2.2.2 Updates 

When you launch Impact, it checks the JRC server through your internet connection. If a 

newer version is found, it will propose you to update your own version. Simply accept 

the update and follow the instructions on screen. 
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2.2.3 Overview of the IMPACT interface 

The interface is divided into three panels – Data; Display and Processing 

Background: blank, Blue Marble map, JRC Sentinel2 2015-2017 and 2018 cloud-free 

composite, Google Satellite and Streets maps, which is the default and automatically 

selected if internet connection is available. 

 

DATA: any vector (.shp) or raster (.tif) layers in DATA and subfolders will be visible 

under this group; 

2.2.4 Practical Session 1: IMPACT functions 

2.2.4.1 Pre-processing 

Zip/DN to TOA reflectance 
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By executing this module, Landsat/Sentinel-2/RapidEye zipped (.tar.gz or .tar.bz) 

archives can be selected from your PC, network drive or external sources; processing 

consists of 

1) Conversion of selected/default bands into single Geo Tiff file, and 2) conversion into 

to top-of-atmosphere (TOA) reflectance (if raw DN values)  

Processing options and calibrations coefficients: 

Landsat 

 
Landsat satellite data products provided by space agencies consist of quantized and 

calibrated scaled Digital Numbers (DN) representing multispectral image data. The 

products are generally delivered in 8/16-bit unsigned integer format and can be rescaled 

to the Top Of Atmosphere (TOA) reflectance and/or radiance using radiometric 

rescaling coefficients provided in the product metadata file, as briefly described below.   

Geo Tiff conversion 

Only (R,G,B,NIR,SWIR1,SWIR2)# bands are extracted, renamed and layer stacked; 

thermal and panchromatic bands are  zipped and stored within the same folder. The 

output directory contains the resulting files with the following naming convention: 

Multispectral GeoTiff file:  [sensor]_[path]_[row]_[ddmmyyyy].tif 
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Multispectral quick look :  [sensor]_[path]_[row]_[ddmmyyyy].gif 

Metadata file: [sensor]_[path]_[row]_[ddmmyyyy].met 

Zipped files for archive: 

[sensor]_[path]_[row]_[ddmmyyyy]_[band{1*,61,62,8,9,10,11,BQA}].tif.gz 

Projection and spatial resolution:  as derived from the source data.  

# Landsat 4/5/7 : bands 1,2,3,4,5,7 Landsat 8 : bands 2,3,4,5,6,7 

* Landsat 8 pre-blue band 1. 

TOA Reflectance Conversion 

NOTE: only applicable for Landsat raw DN type; if Surface Reflectance products, select 

"Keep DN value to skip TOA conversion" 

By converting the raw digital number (DN) values to top-of-atmosphere (TOA) 

reflectance data from different sensors/platforms are calibrated to a common 

radiometric scale, minimizing spectral differences caused by acquisition time, sun 

elevation, and sun–earth distance. 

8bit (or 12bit for Oli) DN to TOA correction formula is as follows: 

ρλ = π * Lλ * d2 / ESUNλ 

where 

ρλ= TOA reflectance for band λ 

Lλ = Radiance for band λ = Mλ * Qcal + Aλ 

Mλ = Band-specific multiplicative rescaling factor 

Aλ = Band-specific additive rescaling factor 

Qcal = Quantized and calibrated standard product pixel values 

d = (1-0.01672*COS(0.01745*(0.9856*(Julian Day Image - 4))) 

θSZ= Local solar zenith angle 

Tm ESUN = [ 1957.0,1826.0,1554.0,1036.0,215.0,80.67] 
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Etm ESUN = [1969.0,1840.0,1551.0,1044.0,225.70,82.07] 

Oli ESUN = [2067.0,1893.0,1603.0,972.6,245.0,79.72] 

Multiplicative and additive rescaling factors are extracted from the metadata file. In 

order to reduce the size of the calibrated data, 32bit Float reflectance values [0-1] are 

then rescaled to 8bit Byte [0-255] with a linear multiplication factor of 255. 

RapidEye 

Data are usually provided as 5 band layer stacked Geo-Tiff files. To convert 16bit Digital 

Number (DN) to radiance it is necessary to multiply by the radiometric scale factor, as 

follows: 

Lλ = DNλ * ScaleFactor(λ) 

where ScaleFactor(λ) = 0.01 

The resulting value is the at sensor radiance of that pixel in watts per steradian per 

square meter (W/m2 sr μm). The TOA correction formula for RapidEye data is as 

follows: 

ρλ = π * Lλ* d2 / ESUNλ * cos θSZ 

where 

● ρλ= TOA reflectance for band λ 

● Lλ = Radiance for band λ 

● θSZ= Local solar zenith angle 

● d = (1-0.01672*COS(0.01745*(0.9856*(Julian Day Image - 4))) 

● ESUN = [1997.8,1863.5,1560.4,1395.0, 1124.4] 

 32bit Float reflectance values [0-1] are then rescaled to 16bit Unsigned Integer [0-

10000] with a linear multiplication factor of 10000. Formulas and parameter are derived 

from [1]. 

Sentinel2 

The Copernicus Sentinel-2 mission comprises a constellation of two polar-orbiting 

satellites placed in the same sun-synchronous orbit, phased at 180° to each other. It 

aims at monitoring variability in land surface conditions, and its wide swath width (290 

km) and high revisit time (10 days at the equator with one satellite, and 5 days with 2 

satellites under cloud-free conditions which results in 2-3 days at mid-latitudes) will 

https://webgate.ec.europa.eu/fpfis/mwikis/impacttoolbox/index.php/Main_Page#cite_note-1
https://webgate.ec.europa.eu/fpfis/mwikis/impacttoolbox/index.php/Main_Page#cite_note-1
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support monitoring of Earth's surface changes. The coverage limits are from between 

latitudes 56° south and 84° north. 

How to get Sentinel2 data:  Copernicus Open Access Hub or  JRC Sentinel2 explorer  

(including server-side pre-processing for lighter download) are only few example. See 

chapter "How to download Sentinel2 data" for further info. 

Once downloaded *SAFE.zip files can be selected from any location (local or remote 

disks) and processed by choosing configuration parameters from the interface hereafter  

 

 
While importing raw .zip files, only selected *.JP2 bands will be processed and 

eventually rescaled , reprojected and subset according to selected parameters. 

Notes: 

- default bands (2,3,4,8,11,12 ) have been selected to match Landsat specs, giving the 

possibility of applying built-in automatic Classification, Forest Normalization, Spectral 

Unmixing 

https://scihub.copernicus.eu/
https://scihub.copernicus.eu/
https://jeodpp.jrc.ec.europa.eu/forobs/sentinel.py
https://jeodpp.jrc.ec.europa.eu/forobs/sentinel.py
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- by selecting a vector file as Area Of Interest (AOI) from the one available in Layers 

section, only intersecting images and/or part of them are processed, reducing 

processing time and image size 

- in case of ingestion of pre-processed (GeoTiff multiband file) Sentinel2 data 

downloaded from JRC Sentinel2 explorer IMPACT will simply extract the file while 

raising a warning message 

- Processed bands name are saved in the GeoTiff metadata tag "Impact_bands"  

2.2.5 Sentinel-2 naming conventions 

 

Useful links: 

Sentinel-2 User Guide: 

https://sentinel.esa.int/web/sentinel/user-guides/sentinel-2-msi 

Sentinel-2 Technical Guide: 

https://sentinel.esa.int/web/sentinel/technical-guides/sentinel-2-msi 

Sentinel-2 Products Specification: 

 https://sentinel.esa.int/web/sentinel/document-library/content/-/article/sentinel-2-

level-1-to-level-1c-product-specifications 

Sentinel-2 User Handbook: 

https://sentinel.esa.int/documents/247904/685211/Sentinel-2_User_Handbook 

2.2.6 Processing Landsat 

We pre-process the Landsat file  

https://jeodpp.jrc.ec.europa.eu/forobs/sentinel.py
https://jeodpp.jrc.ec.europa.eu/forobs/sentinel.py
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-2-msi
https://sentinel.esa.int/web/sentinel/technical-guides/sentinel-2-msi
https://sentinel.esa.int/web/sentinel/document-library/content/-/article/sentinel-2-level-1-to-level-1c-product-specifications
https://sentinel.esa.int/web/sentinel/document-library/content/-/article/sentinel-2-level-1-to-level-1c-product-specifications
https://sentinel.esa.int/web/sentinel/document-library/content/-/article/sentinel-2-level-1-to-level-1c-product-specifications
https://sentinel.esa.int/documents/247904/685211/Sentinel-2_User_Handbook
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Select the Zip to reflectance – and navigate to the Landsat zip files in the data folder 

 

 
 
When the file has finished processing the Logs Monitor will turn green 

 
 
By clicking on the logs monitor – you can review messages – if the logs monitor is red – 

the process has failed. 
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2.2.7 File information, display and contrast 

The file name will now appear in the left-hand Overlays panel – in a directory with the 

path-row and date. 

Double click on the image name and IMPACT will zoom to the image.  If you right click 

on the image name you have a set of options for display, image information etc  

 

The last option ‘File options’ allows you to copy, delete and rename the file. 

Visualisation options allows you to change the band display and the contrast stretch. 

Under ‘Show file info’ you have the details of the image. 

You can move a file up above other files or change its file location by clicking and 

moving it. 
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2.2.8 Extracting an area to work with. 

Drawing an area of interest 

 

To draw an area of interest you need first to activate the function by clicking on "Draw 

Rectangle" or "Draw Polygon" in the upper left corner of the map. When selected, 

Edit/Delete/Save buttons appear. Once the button is enabled, the area of interest can 

be drawn on the map. The draw tool will create an rectangular/polygonal overlay with a 

orange border (while it is drawn the border is blue). 
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Use the ‘draw rectangle’ option from the top of the screen to create a rectangle over the 

forest reserve. Save the rectangle using the option from the top of the screen (e.g. 

aoi), and then use ‘Image clip’.  

 

Image Clip 

 
The Image clip tool can be used with any raster layer to create a clipped layer using: 1) 

a selected GeoTiff image, and 2) a selected vector layer. Image clipping represents a 

crucial step to reduce processing time and data volume. The user has the possibility to 

clip any GeoTiff file from the input directory using predefined vector layer(s) containing 

one or more features each. Vector projection will be on the fly converted to match the 

raster one. Note that clipping can be done only after Zip/DN to TOA-Reflectance. 

 
The dialogue opens and you select your new shapefile and the Landsat image to clip 

the area. 
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The image is clipped and now appears in the Overlay panel with a pre-fix of the 

shapefile. Options are available to do multiple clipping with one shapefile (use individual 

features). 

 
2.2.9 Image classification 

2 classifiers are provided – one a decision tree and the other k-means. You can try both 

to see how they perform. The result of the automatic classification has a suffix – class 
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With Kmeans you can determine the number of classes and add a suffix (e.g. km). 

If you right click on the file name you can apply a number of raster styles or define your 

own either with Define new raster style or from the menu at the top of the screen using 

Raster Styles. 

 

 
You can also recode the classes by right clicking on the file name and using ‘start raster 

recode’. 
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2.2.10 Analysis and Enhancement 

 

Linear Spectral Unmixing – produces a tree band Vegetation, Soil and Shadow image 

Evg Forest Normalisation – uses dark object (forest) to normalise the image 

ND(V,W,S)I Threshold – creates and index (e.g.NDVI) from the bands of your choice 

along with a thematic density slice image 

Disturbance using NBR – takes two images at from different times and looks at the 

difference in NBR – a forest mask can be used to restrict the analysis only to forest 

areas. 

Pansharpen – for use with Landsat 8 pancromatic channel (band 8) 

Principle component – creates a PCA image 

2.2.11 Image Segmentation 

 

Uses the Baatz algorithm to produce segments at different sizes. 

We can use the tabora subset and segment at different Minimum Mapping Units 
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You have the option of giving the resulting polygons a class from a classification that 

you have produced. 

If you have added a classification during the segmentation, you can apply an existing 

vector style to the polygons – or create your own vector style and apply it. Right click to 

Apply classification legend to layer.  Click on T1_class to see results. 

2.2.12 Vector Editing 

Your segmentation attributes can be edited by right clicking on the file and selecting 

Start Editing 

 

You can select a polyon or set of polygons and recode them. 
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2.2.13 Degradation and deforestation detection and reporting 

-          Input of forest change maps and emissions factors 

-          Output of emissions 

 

2.2.14 General Tools 
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Raster Convertion 

Reproject / change pixel size / format / data range / bands 

Vector to raster conversion 

Mosaic – spatial or temporal 

Raster calculation – choose bands and maths / logic to 

Create a new file (e.g. shadow index) 

 Fishnet – creates a sampling scheme (regular or random) over an image in a vector file 

 Zonal statistics – enables you to fill a vector file with the statistics from a raster file. 

 

2.3 Practical Session 2: Processing Sentinel 2 

One of the core functions of the IMPACT tool is to enable users to take Sentinel 2 data in the RAW format 

as provided by ESA, JRC or USGS and process through to a thematic (map) product. 

In this exercise we will take Sentinel 2 scenes downloaded from the JRC web site and process them to a 

land cover map which we will review and show how to edit. 

The data for this exercise are in data folder/sentinel2 

The steps involved in this exercise are the following: 

1.       Installing the IMPACT software 

2.       Processing the S2 input files to a layer stack GeoTIFF with selected bands 

3.       Clipping the image to a user selected outline (shapefile) 

4.       Producing a supervised (decision tree) classification of the image 
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5.       Producing a segmentation of the image with pre-labels 

6.       Reviewing the classification – with the possibility of editing the classes. 

2.3.1 Processing test data set – Sentinel 2 – clipping, classification segmentation and 

recording 

2.3.1.1 Loading Sentinel 2 data 

Directory Structure – under the IMPACT/DATA folder you can organise your data in folders as you wish 

Under the IMPACT directory you will find the START_Impact.bat file to launch the software – this can be 

moved as a link. 

Copy the two RAW ZIP files into your DATA directory 

 
The files have been download from the JRC Web site – see above. 

2.3.2 Processing the input S2 file 

 

The dialogue appears – navigate to the folder where the S2 zip files are located and select them. 
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Here you can choose the bands, the resolution and projection. We can take the default settings – except 

we choose the SHORT naming version. 

2.3.3 Display the processed images 

In the left hand panel right click on the image name zoom to layer and display the bands and the stretch 

you want. Below we see the two images side-by-side.  

 

2.3.4 Image clipping 

Zoom to the image and then using Shift + Mouse zoom to an area of interest. Use DRAW RECTANGLE to 

highlight an area which we will then use for processing.  We select the forest reserve of Katitiu to the east 

of the images – and save to file  - you a shapefile in your Sentinel directory called tabora.shp to help. 
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Now save the area of interest as a shape file in the left hand layer panel under VECTOR with a name of 

your choice. 

This layer will now be used to CLIP the image. 

CLICK the IMAGE CLIP module on the right hand processing panel.  From the drop down menu, select 

the shapefile you saved and the name of your input S2 image. 

Use Individual feature: this option creates output files as many as the individual features of the vector. 

When No is selected, a unique output files containing the bounding box of the features will be used. 
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When you press RUN a clipped subset of the input image will be created – the name will start with 

Clip’ and include the name of the shapefile and the input image. The image can now be seen in the viewer.  

As with other images you can zoom to layer and change the bands and contrast. 
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2.3.5 Producing a Supervised (Decision Tree) Pixel Classification of the Clipped Image 

 

Under classification tools we use automatic classification to produce a pixel based classification. The 

process produces a TIFF file that can be visualised in the IMPACT tool and in other GIS software. The 

resulting classes are: 

 

CLICK on the AUTOMATIC CLASSIFICATION button and select your clipped image. The classification 

will appear the left hand panel. 
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Interface and result.   You can also use K-Means, an unsupervised classifier to create an output file with 

number of classes you want. 

2.3.6 Producing a segmentation of the image with pre-labels 

We will segment the image into polygons and give the polygon a preliminary class name by using the pixel 

based classification we produced in the section above. 

As inputs the process requires:  the clipped image; the classification and some parameters to define the 

level of segmentation. Depending on your computer, the segmentation might take some time. 
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2.3.7 Segmentation Options: 

- Multi-date segmentation: 

·         “No”: selected images are treated individually and the correspondent vector file (ESRI 

Shapefile format) is saved within the image directory; please ensure that segmentation 

parameters are applicable to all selected images, bands selection above any other. 

·         “Yes”: selected images are layer stacked (only selected bands) into a single one using the 

selected bands and weight. Please ensure the geographical overlap. First file is use to extract 

output location and reference projection 

- Use classification to pre-label objects: selected raster files (thematic or not) are used to pre-label objects 

according to occurrence rules (majority, min, max’) either in single or multi-date mode. In the latter case, 

the .dbf file will reflect the top-down order in which files have been selected in the interface, saving (after 

the ID field) as many fields as the input images as on Table 3. 

- Overwrite: set to “Yes” to automatically delete output files (if any) 

- Optimization: if “Yes”, input images are processed using a tiling approach reducing the total amount of 

memory; however, the final segmentation might reflect the tiling patters; do not use in case of small 

images. 

We can use different MMU to determine the size of the polygons. The size of the polygons is determined 

by the MMU and the image properties – so you need to experiment. Below are suggestions from different 

sensors. You can experiment with the S2 data and observe the results. 
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Load Classification Layers with legend – land cover.   
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2.3.8  Recording  

Your segmentation attributes can be edited by right clicking on the file and selecting Start Editing 

 

You can select a polyon or set of polygons and recode them. 
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Module 3:  

Spatial Analysis and Hazard Assessment 
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3 Module 3: Spatial Analysis and Hazard Assessment 

Learning objectives 

By the end of this module you will be able to: 

 Introduce the fundamental concepts in spatial analysis  

 Elaborate basic terminologies and concepts in DRM together with Global and Continental DRM 

frameworks 

 Demonstrate how to undertake hazard assessment and derive some of the indicators and       

thresholds on drought and flood hazards 

 Grasp methods used to produce drought and flood hazard vulnerability and risk maps 

3.1 Introduction to Spatial Analysis 

Spatial analysis is a type of geographical analysis which seeks to explain patterns of human behavior and 

its spatial expression in terms of mathematics and geometry, that is, locational analysis (Dartmouth). The 

main focus of spatial analysis is to understand the spatial distribution, variation, interaction and relationships 

of features or phenomena. According to Carleton College definition, spatial analysis is a set of techniques 

for analyzing spatial data. The results of the spatial analysis are dependent on the locations of the objects 

being analyzed. Software that implements spatial analysis techniques requires access to both the locations 

of objects and their attributes. The other description is from ESRI “Spatial analysis is how we understand 

our world—mapping where things are, how they relate, what it all means, and what actions to take. From 

the computational analysis of geographic patterns to finding optimum routes, site selection, and advanced 

predictive modeling, spatial analysis is at the very heart of Geographic Information System (GIS) 

technology.” 

 The goal of the spatial analysis is to answer spatial questions related to location, pattern, change, 

scenarios, and others. GIS software’s are designed to provide a state of the art tools to process data and 

answer such complex space based questions. There are hundreds of tools under the ArcGIS toolbox to 

help you carry out spatial analysis, however, it is very important to first design a methodology or a model 

which needs to be supported with scientific methods to reach a conclusion.  

 
Common Types of Spatial Analysis  

a) Proximity Analysis is an analytical technique used to determine the relationship between a selected 
point and its neighbors. Proximity analysis is a crucial tool for business marketing and site selection. 
Marketers analyze demographics and infrastructure to determine trade areas. Trade areas are 
continuous geographic areas around a site that generate the majority of revenue. This analysis is 
also called Neighborhood Analysis.  

b) Overlay Analysis  
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Multi-Criteria Analysis (Suitability Analysis) 

In most cases spatial analysis involves multiple layers and criteria for selecting a suitable site or 

identifying specific areas that fulfill certain requirements. For instance, one may need to identify areas in 

Eritrea that are above 1000m above sea level and slope of < 10 degrees. But also the area needs to be 

very close to roads and towns. Such analysis involves multiple parameters and criteria and such analysis 

is called multi-criteria analysis.  

 

Exercise 

Suitability Analysis for irrigation farming (For exercise purposes)  

Parameter Criteria Weight 

Elevation >700m 35% 

Slope <=10 degree 45% 

Access to main road <10km 20% 

   

1) Open ArcMap and Load the following layers from Spatial Analysis  folder under X:/Eri_data/Module3  

 Suitable_elevation.tif 

 Suitable_slope.tif 

 Suitable_road_access.tif 

2) Go to windows/Search and key-in Raster Calculator  

Now we are going to combine all the three layers considering their weight. Double click on 

Suitable_elevation.tif and click on multiply (*) and add 0.35. Plus the Suitable_slope.tif file times 0.45 

plus Suitable_road_access.tif times 0.2. The raster calculator tool should look like this; 
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3.2 Disaster Risk Management 

3.2.1 Basic Concepts and Terminologies in Disaster Risk Management 

The following are some of the common concepts in Disaster Risk Management (DRM) which are useful to 
understand DRM as a process. Some of the following materials are excerpts from Asian Disaster 
Preparedness Center (ADPC). 

1. A disaster occurs when a hazard impacts a vulnerable community causing damage,     
     casualties and disruption. 
2. Vulnerability is a set of prevailing or consequential conditions, which adversely affect the  

            Community’s ability to prevent, mitigate, prepare for and respond to hazardous events. 
3. Capacities are resources, means and strengths, which exist in households and in the  
    Community and which enable them to cope with, withstand, prepared for, prevent, mitigate or  
    quickly recover from a disaster. 
4. Disaster Risk = Hazard (Exposure) x Vulnerability/Capacity 
5. Disaster risk reduction includes all measures, which reduce disaster-related losses of life,  
     property or assets by either reducing the hazard or vulnerability of the elements at risk or by  
     increasing the capacity of at risk communities. 
6. DRM is multi sectoral and Multi-hazard by its very nature 

The common definitions given to the main terminologies in DRM are as follows; 

 
The glass & the water in this example are the hazard – In this example, an unstable glass of water is the 
hazard threatening our laptop on the table. 
The position of the laptop represents the exposure – Exposure in this example is determined by the 
position of the laptop right under the shelf: our laptop is situated in a “hazard prone” area. 
The characteristics of the laptop represent its vulnerability – the laptops is vulnerable to water falling 
from the glass because it is an electronic device that can be heavily damaged by water. If we had a 
plastic bowl on the table, instead of a laptop, vulnerability levels would be much lower, or even non-
existent. 
Disaster Risk – The combination of hazard, exposure and vulnerability generates a risk of disaster: if the 
glass full of water falls from the shelf, it is likely to spill water on the laptop and, in consequence, affect the 
functioning of the laptop, which is very sensitive to water, being an electronic device. 

 

DISASTER 
A serious disruption of the functioning of a community or a society at any scale due to hazardous events 
interacting with conditions of exposure, vulnerability and capacity, leading to one or more of the following: 
human, material, economic and environmental losses and impacts. (UNISDR, 2016) 
A disaster happens when a hazard impacts on a vulnerable population or community whose capacity is 
inadequate to withstand or cope with its adverse effects, resulting in damages, loss and disruption in 
community/society functioning. An earthquake in an uninhabited desert cannot be considered a disaster, 
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no matter how strong the intensities produced. An earthquake is only disastrous when it affects people, 
their property and socio-economic activities. 

HAZARD 
A process, phenomenon or human activity that may cause loss of life, injury or other health impacts, 
property damage, social and economic disruption or environmental degradation. (UNISDR -2016) 
The hazards of concern to disaster risk reduction as stated in footnote 3 of the Hyogo Framework are, 
“hazards of natural origin and related environmental and technological hazards and risks.” Such hazards 
arise from a variety of geological, meteorological, hydrological, oceanic, biological, and technological 
sources, sometimes acting in combination. In technical settings, hazards are described quantitatively by 
the likely frequency of occurrence of different intensities for different areas, as determined from historical 
data or scientific analysis. (UNISDR, 2009) 

Hazards can be single, sequential or combined in their origin and effects. For example, an earthquake 
causes landslides, which dam a river and then causes flooding. A community may be exposed to multiple 
hazards when there is simultaneous occurrence of different hazards.  

VULNERABILITY 
The conditions determined by physical, social, economic and environmental factors or processes, which 
increase the susceptibility of an individual, a community, assets or systems to the impacts of hazards. 
(UNISDR, 2016) 
Vulnerability is a set of prevailing or consequential conditions that adversely affect people’s ability to 
prevent, mitigate, prepare for and respond to hazardous events. These long-term factors, weaknesses or 
constraints affect a household’s or community’s ability (or inability) to absorb losses after a disaster or to 
recover from the damage. Vulnerabilities precede disasters, contribute to their severity, impede disaster 
response, and may continue to exist long after a disaster has stuck. 
Anderson and Woodrow (1989) categorize vulnerabilities into three areas, namely: 
1) Physical/Material Vulnerability: 

For example, poor people who have few physical/material resources usually suffer more from disasters 
than rich people. People who are poor often live on marginal lands; they don’t have any savings or 
insurance; they are in poor health. These factors make them more vulnerable to disasters and means 
that they have a harder time surviving and recovering from a calamity than people who are better off 
economically. 

2) Social/Organizational: 
Experience shows that people who have been marginalized in social, economic or political terms are 
vulnerable to suffering from disasters whereas groups that are well organized and in which there is a 
high commitment to each other suffer less when catastrophe strikes. Weakness in social and 
organizational areas may also cause disasters. For example, deep divisions can lead to conflict and war. 
Conflict of resources due to poverty can also lead to violence. The second area of vulnerability, then, is 
the social/organizational and economic realm. 

3) Attitudinal/Motivational Vulnerability: 
Experience also shows that people who have low confidence in their ability to affect change or who have 
“lost heart” and feel defeated by events they cannot control, are harder hit by disasters than those who 
have a sense of their ability to bring about the changes they desire. Thus, the third area of vulnerability 
is the attitudinal and motivational realm. 

CAPACITY 
The combination of all the strengths, attributes and resources available within an organization, community 
or society to manage and reduce disaster risks and strengthen resilience. (UNISDR, 2009). Capacity may 
include infrastructure and physical means, institutions, societal coping abilities, as well as human 
knowledge, skills and collective attributes such as social relationships, leadership and management. 
Capacity may also be described as capability. Capacity assessment is a term for the process by which the 
capacity of a group is reviewed against desired goals, and the capacity gaps are identified for further action. 
(UNISDR, 2009). Capacity (in contract to Vulnerability) has been included in disaster management initially 
as a guide for both international and local agencies who work with vulnerable communities to link disasters 
to development even in emergency situations disaster survivors have capacities. They are not helpless 
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victims but have coping mechanisms on which to build on for emergency response and recovery. As the 
developmental and risk reduction paradigms in disaster management emerged, for many vulnerable 
groups, the viable track to reduce vulnerabilities has been by increasing their social/organizational 
capacities. 

Capacities are resources, means and strengths, which exist in households and communities and which 
enable them to cope with, withstand, prepare for, prevent, mitigate, or quickly recover from a disaster. 
People’s capacity can also be categorized in the same categories as was done with vulnerabilities in the 
previous section. 

1) Physical/Material Capacity: 
Even the very people whose houses have been destroyed by a typhoon or whose crops have been 
destroyed by floods can salvage things from their homes and from their farms. Sometimes they have food 
in storage or crops that can be recovered from the fields or farm implements for planting again. Some family 
members have skills, which enable them to find employment if they migrate, either temporarily or 
permanently. 

2) Social/Organizational Capacity: 
In most disasters, people suffer their greatest losses in the physical and material realm. Rich people have 
the capacity to recover soon because of their wealth. In fact, they are seldom hit by disasters because they 
live in safe areas and their houses are built with stronger materials. However, even when everything 
physical is destroyed, people still have their skills and knowledge; they have family and community 
organization. They have leaders and systems for making decisions. They have tribal loyalties or church 
affiliations. They have capacities in the social and organizational realm. 

3) Attitudinal/Motivational Capacity: 
People also have positive attitudes and strong motivations such as the will to survive, love and concern for 
each other, bravery and willingness to help each other. These are also important capacities, and form the 
basis for development just as much as the physical resources that people have. Coping 
mechanisms/strategies are generally considered capacities for survival. 

DISASTER RISK REDUCTION (DRR) 
Disaster risk reduction is aimed at preventing new and reducing existing disaster risk and managing 
residual risk, all of which contribute to strengthening resilience and therefore to the achievement of 
sustainable development. (UNISDR, 2016) 

DISASTER RISK MANAGEMENT (DRM) 
Disaster risk management is the application of disaster risk reduction policies and strategies to prevent 
new disaster risk, reduce existing disaster risk and manage residual risk, contributing to the strengthening 
of resilience and reduction of disaster losses (UNISDR, 2016) 

PREVENTION 
Prevention refers to the outright avoidance of adverse impacts of hazards and related disasters (ISDR, 
2009). 

MITIGATION 
Mitigation refers to lessening or limiting the adverse impacts of hazards and related disasters (ISDR, 
2009). Mitigation can broadly be divided into structural mitigation and non-structural mitigations. Structural 
mitigation includes engineering measures such as retrofitting, retaining walls, flood barriers etc. Non- 
structural measures include land-use zoning, building codes, construction policies and bylaws, training on 
structural mitigations etc. 

PREPAREDNESS 
Preparedness refers to the knowledge and capacities developed by governments, professional response 
and recovery organizations, communities and individuals to effectively anticipate, respond to, and recover 
from, the impacts of likely, imminent or current hazard events or conditions (UNISDR, 2009). 

EMERGENCY MANAGEMENT 



 

86 
 

Emergency management is the organization and management of resources and responsibilities for 
addressing all aspects of emergencies, in particular preparedness, response and initial recovery steps 
(ISDR, 2009). 

RESPONSE 
Response is the provision of emergency services and public assistance during or immediately after a 
disaster in order to save lives, reduce health impacts, ensure public safety and meet the basic 
subsistence needs of the people affected (ISDR, 2009). 

RECOVERY 
Recovery is the restoration and improvement where appropriate, of facilities, livelihoods and living 
conditions of disaster-affected communities, including efforts to reduce disaster risk factors (ISDR, 2009). 

DISASTER RESILIENCE 
Disaster resilience is the capacity of a system, community or society to resist or to change in order to 
obtain an acceptable level of functioning and structure. This is determined by the degree to which the 
social system is capable of organizing itself, and the ability to increase its capacity for learning and 
adaptation, including the capacity to recover from a disaster. 

Disaster Risk Management Process 
Disaster Risk Management, as a process can be seen from different points of views; some of these 
include processes from the hazard, disaster governance, and disaster cycle points of views. According to 
a training manual prepared by ADPC, DRM process in general requires the following: 

● Establish the context and build partnerships and rapport based on the mandates and context; 
● Identify the hazards (Hazard Assessment); 
● Determine  the  elements  at  risk  (people  and  health,  property,  livelihoods,  Community  
     structures, critical facilities, environment etc.) (Exposure Assessment); 
● Determine conditions and factors of vulnerability. Why can the elements at risk be damaged?  
     (physical, economic, social, motivational reasons) (Vulnerability Assessment); 
● Identify existing coping strategies and capacities/resources (material, human,  
    institutional/organizational, motivational, etc.) (Capacity Assessment); 
● Assess risks (based on the Hazard, Vulnerability and Capacity Assessment); 
● Identify measures or solutions to reduce the vulnerability of the elements at risk. How to  
    protect and strengthen the elements at risk and how to reduce the impact of the hazard? 
● Prioritize risk reduction measures to undertake: immediate, short-term, medium-term, long-  
    term; 
● Implement the risk reduction measures as planned; 
● Monitor and evaluate the programs 

 

3.3 Global, Continental and National Frameworks/Platforms on DRR 

     a) The Sendai Framework for Disaster Risk Reduction 
The Sendai Framework is a 15-year, voluntary, non-binding agreement which recognizes that the State has 
the primary role to reduce disaster risk but that responsibility should be shared with other stakeholders 
including local government, the private sector and other stakeholders. It aims for the following outcome: 
The substantial reduction of disaster risk and losses in lives, livelihoods and health and in the economic, 
physical, social, cultural and environmental assets of persons, businesses, communities and countries. The 
Sendai Framework for Disaster Risk Reduction 2015-2030 (SFDRR) stresses that there has to be a broader 
and a more people-oriented preventive approach to disaster risk. DRR practices needs to be multi-hazard 
and multi-sectoral, inclusive, and accessible in order to be efficient and effective. Governments should 
engage with relevant stakeholders, including women, children and youth, persons with disabilities, people 
living under poverty, migrants, indigenous peoples, volunteers, and the community of practitioners and 
older persons in the design and implementation of policies, plans and standards. 
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Priorities for Action 

Priority 1: Understanding disaster risk 
Disaster risk management should be based on an understanding of disaster risk in all its dimensions of 
vulnerability, capacity, exposure of persons and assets, hazard characteristics and the environment. Such 
knowledge can be used for risk assessment, prevention, mitigation, preparedness and response. 

Priority 2: Strengthening disaster risk governance to manage disaster risk 
Disaster risk governance at the national, regional and global levels is very important for prevention, 
mitigation, preparedness, response, recovery, and rehabilitation. It fosters collaboration and partnership. 

Priority 3. Investing in disaster risk reduction for resilience 
Disaster risk governance at the national, regional and global levels is very important for prevention, 
mitigation, preparedness, response, recovery, and rehabilitation. It fosters collaboration and partnership. 

Priority 4. Enhancing disaster preparedness for effective response and to “Build Back Better” in 
recovery, rehabilitation and reconstruction 
The growth of disaster risk means there is a need to strengthen disaster preparedness for response, take 
action in anticipation of events, and ensure capacities are in place for effective response and recovery at 
all levels. The recovery, rehabilitation and reconstruction phase is a critical opportunity to build back better, 
including through integrating disaster risk reduction into development measures. 

Based on the experiences from the implementation of the HFA, and in order to reach the targets and 
goals, there is a need for focused actions within and across sectors by States, at the local, national, 
regional, and global levels in four priority areas. An enabling international environment and means of 
implementation are needed to stimulate and contribute to developing the knowledge, capacities and 
motivation for disaster risk reduction at all levels, particularly for developing countries. 

The Seven Global Targets 
1. Substantially reduce global disaster mortality by 2030, aiming to lower average per 100,000 global 

mortality rate in the decade 2020-2030 compared to the period 2005-2015. 
2. Substantially reduce the number of affected people globally by 2030, aiming to lower average global 

figure per 100,000 in the decade 2020 -2030 compared to the period 2005-2015. 
3. Reduce direct disaster economic loss in relation to global gross domestic product (GDP) by 2030. 
4. Substantially reduce disaster damage to critical infrastructure and disruption of basic services, among 

them health and educational facilities, including through developing their resilience by 2030. 
5. Substantially increase the number of countries with national and local disaster risk reduction 

strategies by 2020. 
6. Substantially enhance international cooperation to developing countries through adequate and 

sustainable support to complement their national actions for implementation of this Framework by 
2030. 

7. Substantially increase the availability of and access to multi-hazard early warning systems and 
disaster risk information and assessments to the people by 2030. 

The Sendai Framework document is provided for you under X:\ERI_data\Module3\DRM reading 
materials folder. 

b) African Programme of Action 
Programme of Action for the Implementation of the Sendai Framework for Disaster Risk Reduction 2015-
2030 in Africa was crafted in line with the Africa Regional Strategy for Disaster Risk Reduction. The Program 
of Action (PoA) details the need to align all DRR activities in the continent of the four priority areas of the 
Sendai Framework. The document explains the role of key stakeholders from the UN to AU and national to 
Sub-national actors in the implementation of the programme. Issues related to resource mobilization 
strategies and monitoring of the progress are all covered. The document is provided for your additional 
reading under DRM reading documents folder. 
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National DRR Platforms 
Countries have been striving to put in place functional institutions and DRR strategies, policies, plans and 
acts which are all aimed at reducing the negative impacts of disasters and building the resilience capacity 
of their respective communities to Disaster risks. In the region several countries have already developed 
national strategies/policies in DRM and this is a very positive step towards resilience building in the region. 

3.4 Hazard, Vulnerability and Risk Assessment 

According to Caribbean handbook on disaster risk information management, Hazard data is generally the 
most difficult to generate. For each hazard type (e.g. Drought, flooding, landslide, etc.) so- called hazard 
scenarios should be defined, which are hazard events with a certain magnitude/intensity/frequency 
relationship (e.g. flood depth maps for 10, 50 and 100 year return periods). Different types of modelling 
approaches are required for the hazard scenario analysis, depending on the hazard type, scale of analysis, 
availability of input data, and availability of models. Generally speaking a separate analysis is required to 
determine the probability of occurrence for a given magnitude of events, followed by an analysis of the 
initiation of the hazard. Under this section we are going to work on two scenarios on the main hazards in 
Eritrea namely drought and floods.  

3.4.1 Drought Hazard Assessment 

Drought is an insidious natural hazard that results from lower levels of precipitation than what is considered 
normal. When this phenomenon extends over a season or a longer period of time, precipitation is insufficient 
to meet the demands of human activities and the environment. The east African region is susceptible to 
recurrent droughts that immensely devastated lives and livelihoods for millions of people in the region. The 
drought cycle in the region is cyclical and when strike often sustained for more than one season which often 
end up in catastrophic damages both to life and property. The trend in the number of people affected by 
drought from 1900 to 2015 is given below (Source: EM-DAT/CRED). 

The American Meteorological Society (AMS) categorizes drought in to meteorological/climatological, 
agricultural, hydrological and socio-economic drought. Meteorological drought refers to monitoring of 
rainfall conditions and where rainfall is below normal conditions. Meteorological and climatological drought 
is defined in terms of the magnitude of a precipitation shortfall and the duration of this shortfall event. 
Agricultural drought links the various characteristics of meteorological drought to agricultural impacts, 
focusing on precipitation Shortages, differences between actual and potential evapotranspiration, and soil 
moisture deficits. Hydrological droughts are related to the effects of periods of precipitation shortfall on 
surface or subsurface water supply, rather than to precipitation shortfalls directly. Socioeconomic drought 
is associated with the supply and demand of some economic good with elements of meteorological, 
agricultural, and hydrological drought. For monitoring and mapping of drought in the greater horn of Africa 
region meteorological and agricultural drought conditions are considered in this training. 

Meteorological Drought: Monitoring of the meteorological drought can be done in different ways and one 
of the most common ways is the Standard Precipitation Index (SPI). McKee, Doesken and Kleist (1993) 
developed the Standardized Precipitation Index (SPI) for the purpose of defining and monitoring drought. 
The SPI was designed to quantify the precipitation deficit for multiple time scales, and to reflect the impact 
of drought on the availability of different water resources. Soil moisture conditions respond to precipitation 
anomalies on a relatively short time scale, while groundwater, stream flow and reservoir storage reflect 
longer-term precipitation anomalies. Akinremi, McGinn and Barr (1996) state that the spatial and temporal 
dimensions of drought create problems in generating a drought index because not only must an anomaly 
be normalized with respect to location, but the anomaly must also be normalized in time if it is to produce 
a meaningful estimate of drought; the SPI accomplishes both. It also provides spatial and temporal drought 
vulnerabilities from the point of rainfall scarcity. For you to make meaning to your SPI data there need to 
set a standard intervals as proposed by the developers. For now let’s set it to 9 classes as follows;  

A regionally blended (observed rainfall with Chirps satellite data) at 5km resolution is used to produce 
seasonal SPI for 1984, 2009, 2011 and 2015. One distinct seasons are used in this analysis for the region 
and these are from March to May (MAM), June to August (JJA) and September to December (SOND). The 
MAM is the main rainfall season for GHA countries in the equatorial and some parts in the Southern sectors. 
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JJAS is the main rainfall season for countries in the northern sector. A sample map of SPI at seasonal scale 
for the Greater Horn of Africa is given below:  

  
 
NOTE: The weakness of SPI is over estimation in dry and desert areas and thus careful analysis          
             is advised.  
 
A sample SPI for Eritrea for June to September 2015 is given below.  
 

 
In drought hazard assessment we are going to use two indicators for drought severity, namely the rainfall 
anomaly as calculated through Standardized Precipitation Index (SPI) and the Vegetation Anomaly as 
calculated through Vegetation Health Index (VHI). 
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3.4.2 SPI based drought hazard assessment 

Standardized Precipitation Index (SPI) can be calculated as a function of the difference between current 
rainfall condition and Long Term Average (LTA) and normalized by standard deviation of the rainfall for the 
years under consideration. The World Meteorological Organization (WMO) recommends to use data from 
1981-2010 to calculate long term average.  

3.4.2.1 Working with SPI  

For this exercise SPI data layers for Eritrea are generated based on the combined rainfall seasons from 
April to October. Please open these layers by following the steps below;   

1) Open ArcMap and add the following layers from X:\ERI_data\Module3\Drought\SPI folder  
▪ SPI_JJAS1984.tif 
▪ SPI_JJAS2009.tif 
▪ SPI_JJAS2015.tif 

The black and white images has got values and the symbology can be set manually or imported from the 
existing *.lyr file. For this exercise we will import a symbology.  

2) Double click on SPI_JJAS1984.tif and go to symbology and under show click classified.  
3) Now click on import and go to X:\ERI_data\Module3\Drought\SPI folder and select 

SPI_symbology.lyr file 

 
  
4) Click Ok and now your map view should look something similar to this.  
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Exercise 3.1  

Follow similar steps to change the symbology for 2009, and 2015 SPI data layers.  

 

3.4.3  Zonal Statistics  

Calculate Zonal Statistics to produce seasonal meteorological drought hazard map for Admin Level 2 of 
Eritrea 



 

92 
 

1. Add the ERI_Adm2 layer from X:\ERI_data\Module 1\Admin 

2. Go to the main menu in ArcMap Windows >> Search  now type  Zonal Statistics and click on 

Zonal Statistics as a Table 

3. Set ERI_adm2 as input raster or feature zone data and NAME 2 as zone field. 

4. Select SPI_JJAS2009.tif file as input value raster and save the output table under 

X:\ERI_data\Module3\Output folder by the name Zonal StatisticsSPI_2009.dbf. 

5. Select MEAN as statistics type and click Ok 

Once completed you should be able to see table added to your table of contents. You can open 
the table under the values field, you can see which district has the lowest mean SPI value.  

If you wish to produce the drought severity map based on the rainfall anomaly as measured by 
the SPI you can follow these steps; 

Now we are going to join the two tables ERI_adm2 and Zonal statistics_SPI2009 using 
the common field “NAME2” which is Zone 

6. Right click on ERI_adm2 layer and click on the Join and relate >> Join 
7. Select ERI_adm2 in the first drop down field and Zonal statistics table in the second and NAME 2 

under the third dropdown 
8. Click Ok and you can open attribute table of ERI_adm2 and you find that the two tables are 

joined. Now we are ready to produce drought severity map of districts based on the SPI values. 
9. To save the merged tables as one shapefile you need to right click on ERI_adm2 and 

export data. Save it under X:\ERI_data\Module3\Output with the file name 
Drought_hazard_severity.shp. Your new map will be added automatically to the table of 
contents. 

10. Let’s produce a drought hazard severity map based on the mean SPI with the following 
3 range (-150 to -200; -200 to -250 and -250 and less). 

11. Double click on the Drought_hazard_severity.shp layer and go to symbology 
12. Go to Quantities and graduated colors. Now choose MEAN as value field and set the 

number of classes to 5. 
13. Click on Class and set the above range and choose a color (Blue to dark red) and Click 

Ok 

Now you should get a map something similar to this.     
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3.4.4 Downloading SPI Data 

Standardized Precipitation Index (SPI) can be obtained from ICPAC Data library & Maproom 
(http://digilib.icpac.net/). Step by Step on how to access the data is shown below: 

●        Open this link (http://digilib.icpac.net/) and click on Data by Source. 

 

http://digilib.icpac.net/
http://digilib.icpac.net/
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●        Click on ICPAC>>CHIRPS-BLENDED>>monthly>> 

 

 

 

 

●        ChangeTime, Longitude and Latitude as shown below 

●        ThenRestrict Ranges>Stop Selecting 

●        Click on Data Flies> then Click on GeoTIFF Image as shown below 

●        Once you are sure of the month, Click on e.g. 200908 GeoTiff for GIS 

●        Download all the four months to make a season. 
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3.4.5 Vegetation anomaly based drought hazard assessment 

Vegetation Condition Monitoring is an important activity and can be done in many different ways. The 
Vegetation Health Index (VHI) represents overall vegetation health and it is a combination of Vegetation 
Condition Index (VCI) and temperature condition index (TCI). While VCI indicates the short-term weather-
related NDVI fluctuations from the long-term mean, the TCI shows the relative change in thermal condition 
of brightness temperature (NOAA Star). 

Compared to ground-based and NDVI-based (two-channel algorithm) detection systems, this new method 
provides earlier drought warnings. It also makes it possible to estimate areas under droughts of different 
severity, and to diagnose the potential for drought development prior to the actual start of drought 
conditions. One of the important advantages of this method is that it makes use of a combination of the 
normalized difference vegetation index (NDVI), normally used alone, and the 10.3-11.3-um thermal 
channel. Assessment of temperature conditions permits one to identify subtle changes in vegetation health 
because the effect of drought is more dramatic if a shortage of moisture is accompanied by excessive 
temperatures. This method was validated in all major agricultural countries around the world. (Kogan 2002) 

The VCI and TCI were useful to assess the spatial characteristics, the duration and severity of drought, and 
were in a good agreement with the precipitation patterns. (Ghosh 2007). NOAA STAR website stated that 



 

96 
 

the VHI reflects indirectly a combination of chlorophyll and moisture content in the vegetation health and 
also changes in thermal conditions at the surface. This new approach combines the visible, near infrared, 
and thermal radiances in a numerical index characterizing vegetation health. This approach is extremely 
useful in detecting and monitoring such complex and difficult-to-identify phenomenon as drought. The VH 
values below 40 are used for identifying vegetation stress which is an indirect drought indicator. The VH is 
very useful for early drought detection, assessing drought area coverage, duration, and intensity, and for 
monitoring drought impacts on vegetation and agricultural crops. Vegetation condition index (VCI). VCI was 
first suggested by Kogan (1995, 1997). It shows how close the NDVI of the current month to the minimum 
NDVI calculated from the long-term record. 

Where, NDVImax and NDVImin are calculated from the long-term record (e.g., 18 years) for that month (or 
week) and j is the index of the current month (week). 

For compositing the weekly VHI values a maximum of the season is calculated and the following map 
presents the results for the three seasons from 2009 to 2016 in the atlas map of IGAD/ICPAC. For 
compositing the weekly VHI values a maximum of the season is calculated and the following map [presents 
the results for the three seasons from 2009 to 2016. 

To generate the agricultural drought using VHI, the techniques used for SPI are similar except the range 
and thresholds of the values.   

 
 

3.4.6 Classify VHI values to standard classes 

1. Open ArcMap and add the following VHI layers from X:ERI_data\Module3\Drought\VHI folder 

●      VHI_Week 4 November 1984.tif 

●      VHI_Week 4 November 2009.tif 

●      VHI_Week 4 September 2019.tif 

2.  Now classify the layers. Right click on the VHI_Week 1 September 2009 layer and go to 

symbology. Under show click on classified and set the number of classes to 6 and click on 

classify to set upper limits of the classes. 

3. Set the class interval 0, 20,40,60,80,100 and click Ok 
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4. Now import symbology from X:\ERI data\Module3\Drought\VHI folder and click Ok choose the 

color range from the color ramp and click Ok. 

Your map looks similar to the one below 

VHI values under 40 are considered to be vegetation under stress condition and some literature 

indicated that this is a proxy indicator for agricultural drought. This threshold can be used for 

monitoring agricultural drought in croplands and rangelands. 

Exercise 3.2 

Produce the agricultural drought map for the first week of November 20015 and 2009 for all the districts of 
Eritrea and identify top three districts under severe vegetation stress conditions during these Week of the 
month.   

3.4.7 Downloading vegetation Health Index (VHI) data 

Vegetation Health Index (VHI) data can be obtained from NOAA’s Advanced Very High Resolution 

Radiometer (AVHRR). Note that this is available at 4 km resolution and if higher resolution is needed, 

consider using data from other sources such as MODIS. 

● Open the webpage for downloading VHI’s from NOAA’s AVHRR. 

ftp://ftp.star.nesdis.noaa.gov/pub/corp/scsb/wguo/data/Blended_VH_4km/geo_TIFF/  

● Scroll to the bottom of the page (note that this is a weekly data, each TIFF file is for the entire world, 

the naming convention includes the year followed by the week). For Example: P201801 is the first 

week of January 

● Download all the required weeks to average if you need monthly data. 

http://ftp.star.nesdis.noaa.gov/pub/corp/scsb/wguo/data/Blended_VH_4km/geo_TIFF/
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3.5 Drought, vulnerability and risk assessment 

One of the most important aspects of vulnerability assessment is to identify the elements that are at risk of 
an impending disaster. Depending on the nature of the hazard we can list a number of elements that can 
be at risk and in this case we are working on drought hazard. Let’s consider human and livestock population 
as two elements at risk to further make a meaning to our hazard and risk assessment. These information 
are also key for preparedness, mitigation and response plans. 

3.5.1 Elements at Risk  

Human Population estimates from Worldpop data Layer (100 meter resolution) for 2019 

1.  Open ArcMap and load ERI_Population_2019.tif layer from X:\ERI_data\Module1\Population 
folder  

2.  Double click on ERI_Population_2019.tif and import a Pop_symbology from 

X:\ERI_data\Module1\Population folder 

3.  Now your population map should look something like this  
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1.  Now load the Drought_hazard_severity.shp layer you produced earlier under Step 9 

2.  You have hazard and population layers. Now in order to identify the total population exposed to 

the drought hazard based on JJAS SPI values you can generate the total population from the 

population raster above. 

3.5.2 Vulnerability 

The conditions determined by physical, social, economic and environmental factors or processes, which 

increase the susceptibility of a community to the impact of hazards. Some countries are more vulnerable 

to a certain hazard than others. Even in one country some regions and districts can be more vulnerable to 

a specific type of hazard than the others. This is due to several factors including physical, economic, social, 

cultural…etc factors. The east Africa region, for instance is vulnerable due to over dependence on natural 

resources and primary activity, over reliance on rain- fed agriculture, low level of development, and 

inadequate institutional and economic capabilities among many others. 

Mapping vulnerability requires to look at several factors including those mentioned above and even more. 

For now we will be using the following indicators; 
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Factor Indicator Range/threshold/criteria Remark 

  

  

  

  

PHYSICAL & 

ECONOMIC 

  

  

Access to major 
Roads 

(Primary, 
Secondary and 
tertiary roads only) 

(data source: 
Roads/HDX) 

  

 

 Livelihoods 

(data source: FAO-
geonetwork) 

Very poor/Inaccessible (>15km) 

Poor Access(10-15km > 3 hrs) 

Moderate Access(5-10km) 2 hrs  

Very Good Access (<5km) 1 hrs 

  

  

   

Very highly 

 High  

Low 

Very low 

 

 

 

  

Also consider adding the layers of your choice 

 

You can combine all of these layers to produce a vulnerability map that shows a combined effects of factors 

across the country. 

3.5.3 Vulnerability Map 

How to Combine Several Layers to Produce Vulnerability Map 

Important: Before you start, make sure that all the layers are important indicators and represented with a 

correct data. All you GIS data needs to be in raster format and the layers have the same number of classes. 

It is also important to make sure the number ranking reflects or measures the level of importance or level 

of severity for vulnerability. 

1.  Load the following three layers from X:\ERI_data\Module3\Drought\Vulnerabilityfolder 

a. Livelihoods.tif 

b. Access to roads.tif 

2.  Go to Windows >> Search >> raster calculator. Open rater calculator 

3. Now you will add all the layers and combine both. But before that you need to give weight 

to each of your parameters based on their importance to decide the output. For this 
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exercise Let's assume that livelihood is the most important factor to determine Vulnerability 

and gets 70% weight and Access to roads will get 30% importance.  

4. Double click Livelihoods layer to add it to the raster calculator and use multiplication (*) 

operator and give a weight (0.6). Click on the plus sign (+) and add Accessibility and 

multiply it by 0.3. The raster calculator should look something like this.  

 

5. Name the output raster as Drought vulnerability.tif and save it under 

X:\ERI_data\Module3\Output folder and click Ok 

6. The values of the pixels indicate level of vulnerability and go to symbology and use 

stretched the raster from high to low values. You can see such a map 
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Can you explain this map with the necessary precautions for preparedness planning? 

What are the strengths and weaknesses of this map? 

You can also take this result further to combine it with drought hazard map (SPI) for JJA 2015 to produce 

drought risk map. The poverty and related layers can be added to depict the lack of capacity indicated in 

the risk equation. 

 How to Produce a Risk Map (Example) 

3.5.3.1.1  Risk is a factor of hazard, exposure and vulnerability versus capacity. You have two of the layers 

1.  Open the Drought_hazard2015.tif  and vulnerability.tif layers from 

X:\ERI_data\Module3\Risk folder 

2.  As you can notice the two layers are standardized and classified into three classes. Now go to 

Windows >> Search for Raster calculator and open it 

3.  In the Raster calculator double click on Drought_hazard2015 and give it a weight 

of 0.75and click on multiplication (*) sign and double click on vulnerability and 

multiply it with 0.25. This is to indicate that the hazard map is by far the most 

important determining factor (3/4th) compared to the vulnerability. This is to say 

where there is no hazard vulnerability alone can’t produce a risk.  

 

3. Set the output name to Drought Risk_2015.tif and save it under X:\ERI_data\Module3\Outputs 

folder and click Ok to run the operation 

Now you can open the drought risk layer and choose appropriate legend as to show low,  
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Which districts are at high drought risk for the given season/year?  

 

 
 

3.6 Flood Hazard/Risk Assessment 

 

Learning Objectives: 

●   Causes of Floods? 

●   What is a Flood Hazard? 

●   Flood Hazard Assessment Methods 

○   Use of Historical data (the past flood approach) 

○   Hydrological and hydraulic approach (flood modelling) 

○   Temporal Satellite Data Analysis 

3.6.1 GLOSSARY 

Cross section is the distance perpendicular to the direction of flow 

Discharge is the rate of flow of water measured in terms of volume over time (i.e. the amount of 

water moving past a point). Discharge and flow are interchangeable. 

Flow Accumulation tool calculates accumulated flow as the accumulated weight of all cells flowing 

into each downslope cell in the output raster. If no weight raster is provided, a weight of 1 is applied 

to each cell, and the value of cells in the output raster is the number of cells that flow into each cell. 

The result of Flow Accumulation is a raster of accumulated flow to each cell, as determined by 

accumulating the weight for all cells that flow into each downslope cell. 
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Source:ESRI 

Flow direction tool calculates the direction water will flow using slope from neighboring cells. This 

is usually determined by the direction of the steepest descent in each cell.The result is a raster of 

flow direction from each cell to its steepest downslope neighbor. 

Flood level is the height or elevation of floodwaters relative to a datum. 

Source:Environment and Climate Change Canada 

Floodplain is the land adjacent to a river or creek that is periodically inundated due to floods. The 

floodplain includes all land that is susceptible to inundation by the probable maximum flood event. 

Hydrologically conditioned DEM(Hydro DEM) is a DEM whose flow direction defines expected 

flow of water over the terrain (DEM). 

Peak flood level, flow or velocity is the maximum flood level, flow or velocity occurring during a 

flood 

Runoff is the amount of rainfall from a catchment that ends up as flowing water in the river or creek. 

Watershed is the area where all the water that is under it or drains off of it goes into the same 

place. 
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Source: NASA 

Causes of Floods? 

Causes of floods can be due to various reasons, such as natural, man-made and Effect of climate 

change. These are categorized into, 

Natural: Flash floods, Flood, Coastal Flood (due to cyclones/typhoons) 

Man-made: Urban development/ drainage congestion, Dam failures, Watershed activities 

(deforestation) 

Climate Change Effect. 

Flood: An overflow or inundation that comes from a river or other body of water and causes or 

threatens damage. Any relatively high stream flow overtopping the natural or artificial banks in any 

reach of a stream is known as flood. 

Flash flood: The result of heavy or excessive amounts of rainfall within a short period of time, 

usually less than 6 hours, causing water to rise and fall quite rapidly. 

What is a Flood Hazard? 

To analyse the nature and mechanisms of flooding including frequency, velocity and magnitude. 

Floods need to analyse floods qualitatively and quantitatively with the aim of gaining an 

understanding of the nature of flooding to: 

• Identify the probability of a flood occurring. 

• Identify the specific future time period. 

• Identify the area and intensity of impact. 

Source: UNISDR, 2004.  

Flood Hazard Assessment Methods 

Flood hazard assessment can be conducted in various ways depending on the data availability. The method 

of carrying out the assessment depends on the information, technology and resources available. Most 

commonly used methods are 

●   identifying the probability of flood occurrence 

●   Flood Modelling (Hydrological and Hydraulic) approach 

●   Temporal Satellite Data Analysis 

Identifying the probability of flood occurrence: The return interval, or return period, places magnitude 

of floods in terms of their expected frequency giving a probability of a particular flood occurring. There are 
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a vast number of methods that can be used to calculate or determine return intervals based on the data or 

lack of data available. This is assessed using the historical data of past flood events and popularly known 

as flood frequency analysis.  

The 100-year flood is a common design flood use delineate floodplains and design structures. Often there 

are not enough records to determine the magnitude of the 100-year flood; this must then be done by 

empirical extrapolation using frequency distributions (WMO 1999). 

Output from the probability of flood occurrence (Flood Frequency Analysis) will be Flood gauge height for 

different probability of flood occurrence. Different gauge heights can be used to map flood extents of 

different probability of flood occurrences in a GIS environment to delineate flood hazard zones. 

The relationship between the return period and probability of occurrence, stage / water level and damage 

is shown in the figure below.  

 

Flood Hazard is usually categorized as high, medium and low and very low intensity as per the magnitude 

of maximum river discharge return period / probability indicated in the following table.  

Table 3.7: Classification of Probability 

Flood Hazard Category Return Period (years) Probability (%) of occurrence 

High < 10 >  0.1 

Medium 10 to 50 0.1 to 0.02 

Low 50 to 200 0.02 to 0.005 

Very Low > 200 < 0.005 

Source: Review of Flood hazard Mapping, EU, 2008. 
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Flood Modelling (Hydrological and Hydraulic) approach: 

Models can be used to determine the occurrence of floods based on actual or hypothetical rainfall events. 

Flood simulation is achieved by combining a hydrological model to predict flood flows with a hydraulic model 

to predict inundation levels. Conceptually, hydrologic and hydraulic modelling is shown in figure below.  

 

Hydrologic and Hydraulic Modelling  

Many hydrologic models exist in literature, however most popularly used models are given here.  

Model Web Link Model Description 

HEC-HMS //www.hec.usace.army.mil/ 

software/hec-hms/ 

  

Hydrologic model which can be used to generate 

flood hydrograph at any selected location in the river 

system 

HEC-RAS 

  

//www.hec.usace.army.mil/s

oftware/hec-ras/ 

  

HEC-RAS Version 5.0 has the ability to perform  

one-dimensional (1D) and two-dimensional (2D) 

hydrodynamic routing within the unsteady flow. 

Note: There are many more models are available. However more easily usable models are given above.   

Components of hydrologic modelling using HEC-HMS to predict flood flows is pictorially shown here.  
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Components of Hydrological Model 

Components of hydraulic modelling using HEC-RAS to predict inundation levels is pictorially shown here.  

 

Components of Hydraulic Model 

3.7 Flood Hazard Assessment using EO Data  

3.7.1 Satellite Data Analysis 

Optical Satellite Data: Optical remote sensors measure the reflectance from objects on the ground.  Pure 

and deep-water bodies absorb most of the electro-magnetic energy and reflect very little energy.  Flood 

water, because of different sediment concentrations, reflects considerable energy in different bands, 

including near infra-red (NIR) region. The flood water signature generally mixes with cloud shadow and also 
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with mixed pixels of cloud and cloud shadow. In some cases, it mixes with large urban areas / built up lands. 

Flood inundation layer is extracted by various techniques such as visual interpretation, unsupervised and 

supervised classification using satellite data acquired in optical wavelengths. A sample flooded area 

represented in optical satellite data is shown below.  

 

Flood area represented in optical satellite data 

Using this data, either supervised or unsupervised classification techniques is to be used. In case of 

supervised classification maximum likelihood classification can be used. Care must be taken to see the 

different signature of water are given as training sets since the spectral signature varies with turbidity of 

water. After classification check the classification accuracy. Since no ground information will be available, 

it is better to overlay the classified layer over the image and check whether the classification is proper or 

not. The flood image as well as the pre flood image has to be classified. 

Using arithmetic operations the extent of water in the pre-flood image has to be subtracted from the flood 

image so as to delineate the inundation due to flood. In this process, all the permanent water bodies as well 

as pre Flood River courses will be subtracted resulting net flood inundation. 

Microwave satellite data:  The advantage of using radar data over the optical data is its ability to penetrate 

cloud cover and also data acquisition during day and night.  Water surfaces are generally smooth at radar 

wavelengths and can be regarded as specular reflectors which yield small backscatter.  Hence, water is 

regarded as low intensity areas whereas the surrounding terrain corresponds to brighter intensities, as 

shown in figure below.  

 

Flood area represented in microwave satellite data 



 

110 
 

In case of microwave data, backscatter (db) values have to be computed and the image has to be classified. 

If the data is available in full resolution and with all other parameters only, the db values can be computed. 

However in case of near real time flood monitoring the data will be received in compressed format (Radarsat 

data) through ftp. In such case the data has to be classified using threshold technique. Intensities below 

the threshold are regarded as flood or open water, whereas pixels with intensities above the threshold are 

regarded as dry land.  The threshold will depend on the contrast between the land and water classes, and 

generally needs to be set for each SAR scene.  The backscatter depends on the frequency, incidence 

angle, polarization and is sensitive to the ripples on the water surface induced by wind waves. The 

demarcation between water and land is distinct, at higher incidence angle of 45º and is difficult at 23º 

incidence angle and may lead to error in classification.  This is because the contrast decreases with 

decreasing incidence angle. 

Thresholding / density slicing technique are used for satellite data acquired in microwave wavelength. It is 

most common when the data is classified there will be some scattered pixels will get misclassified may be 

due to spectral overlap. These unwanted pixel has to be removed either manually or using sieving 

techniques. Especially cloud shadows in optical data and hill shadows in microwave data will interfere with 

water delineation. After necessary editing the final inundation layer has to be generated.  

Temporal Satellite Data Analysis: The pre and post flood satellite data is quite useful for assessing the 

extent of flood. The pre and post flood satellite data has to be rectified geometrically with a suitable 

projection system and registered exactly. Otherwise errors will arise while composing and computation of 

statistics of flood inundation areas. Always rectify a satellite scene with respect to a topographic map and 

use it as a master for all other scenes so as to maintain the uniformity. The ground control points should be 

uniformly distributed over the area of interest so that the registration will be perfect. In case of microwave 

data the speckle has to be removed using filters. From experience it is found median filter will suppress 

speckle to the satisfactory levels. 

 

3.7.2 Selection, Download and Pre-Process Sentinel-1 data 

Introduction 

Floods are one of the most widespread, frequent, and recurring natural disasters. Floods are a 

consequence of the increasing frequency of heavy rains, changes in upstream land-use, and a continuously 

increasing concentration of population and assets in the flood plains. Floods can occur anywhere because 

of heavy rain and can be of different intensities—from small flash floods to sheets of water engulfing huge 

areas of land, causing destruction either way. 

Over the years, advances have been seen in remote sensing measurements, which are gradually replacing 

or compensating in situ measurements. Aerial reconnaissance has been effective for determining the 

spatial extent of river flooding in detail for relatively small areas. 

Even though the use of image data from optical satellite sensors (like Pan, LISS, etc.) in the visible or 

infrared portion of the spectrum is very useful for studying land features, their usefulness is limited during 

the rainy season due to cloud cover being visible on the image. On the other hand, the microwave portion 

of the spectrum gives cloudless images even during the monsoon season. Microwave remote sensing data 

can penetrate clouds, which is important for monitoring flood events because they commonly occur during 

periods of extended rainfall or cyclonic storms. However, for most remote sensing solutions, the revisit 

frequency (i.e., the time between two measurements in the same place) is too low for monitoring purposes, 
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or the spatial coverage is limited. Both active and passive microwave data have been extensively explored 

for flood monitoring. 

In this exercise, you will be exploring the freely available microwave satellite data from the first of the 

Copernicus Programme satellite constellation conducted by the European Space Agency, which consists 

of two satellites, Sentinel-1A and Sentinel-1B that carry a C-band synthetic-aperture radar instrument which 

provides a collection of data in all-weather, day or night. 

Learning Objectives: 

The objective of this module is to familiarize with Sentinel-1 satellite data sets for flood studies. After 

completing this session, the course participants will be able to download the Sentinel-1 satellite data of 

flood affected area and will learn how to use it in the next session. 

●  Identify an area of interest (AOI) which was flood affected recently  

●  Search the Sentinel-1 satellite data coverage in the AOI. 

●     Select and download the Sentinel-1 satellite data for the AOI. 

Data Input:  Area of Interest (to be selected by the participants) Example:  

Output:  Sentinel-1 satellite data covering the AOI 

 Accessing the Sentinel-1 satellite data 

 Create a User Account 

Go to Copernicus Open Access Hub (https://scihub.copernicus.eu/dhus) . In the top-right of the web 

map, click the SIGN UP  button. Insert valid entries for your name, email and location. Click register. 

Validate your email and Login using the username and password. 

With a few clicks of the mouse, you will gain access to ESA’s Sentinel data. 

 

 

https://scihub.copernicus.eu/dhus
https://scihub.copernicus.eu/dhus
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Select Your Area of Interest (AOI) 

Where is your study area? 

 Answer:  

Using the SEARCH CRITERIA  text box in the top-left, type in your area of interest. 

Example: Type ‘Eritrea ’ or select an area of interest and Click search option.   

Using the Map Layer option (on right side) you can change the background map / image. Use PAN option 

(at the bottom of the screen) to PAN to the area of interest and zoom into some parts of Eritrea and use 

BOX option draw a rectangle in the area of interest. (You are free to select any other area of interest, if you 

know which area is flooded very recently?) 

Click on the top left corner of the search window as shown for the advanced options.  

 Now select the below given options of selecting suitable data. 

Sort by: Ingestion Date 

Order By: Descending 

Sensing Period: Select 1 July 2019 to 29 October 2019 (if your AOI is different, please select suitable 

date) 

Product Type: GRD 

 

What is Sensing Period? 

  

____________________________________________________________________________ 

Mission: Sentinet-1  

 

What are these parameters? Explore the Sentinel Product Catalogue at 
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https://sentinel.esa.int/web/sentinel/missions/sentinel-1/data-products 

Click Search option. 

From here your search will yield results for all the Sentinel satellite data available Sentinel-1 (Synthetic 

Aperture Radar C-Band) swaths are depicted in red. 

 

See the product thumbnails for more details of the search results. 

 

Search Results contain how many products? 

  

________________________________________________________________________ 

 

https://sentinel.esa.int/web/sentinel/missions/sentinel-1/data-products
https://sentinel.esa.int/web/sentinel/missions/sentinel-1/data-products
https://gisgeography.com/synthetic-aperture-radar-examples/
https://gisgeography.com/synthetic-aperture-radar-examples/
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As we are working with large data sets, you will have to be patient with download speeds. It’s easy for the 

server to timeout during the download. 

Select the product you want to download. S1A is Sentinel-1A. 

Go through the search results and select this Sentinel-1A data.    

S1B_IW_GRDH_1SDV_20190907T032258_20190907T032323_017926_021BD7_99E0.zip 

Why this data is selected? 

  

_________________________________________________________________________ 

  

Before downloading, click on the icon ‘eye’ in the selected data window to preview the data, as shown 

below.  

 

The area of interest selected earlier and the frame of satellite data selected now are the same or different?  

 

Answer is _______________________________________________________________________ 

 

What additional information you can get from this preview window? 

  

________________________________________________________________________ 

  

________________________________________________________________________ 

  

Click on Download URL next to the product thumbnail or Download Arrow @bottom right corner to 

download the data. Since it will take time to download, we have downloaded the data and provided for 

use in this session. 
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3.7.3 SENTINEL – 1 SAR DATA PRE-PROCESSING 

Download SENTINEL Toolbox 

  

Download and install the latest ESA-SNAP-SENTINEL Toolbox (Open source software from ESA) 

Link: http://step.esa.int/main/download/ 

 

The webpage will look like this. 

 

 
 

Select suitable Windows / Mac version suitable for your laptop and download the software. 

 
Install the downloaded SNAP software for using the downloaded Sentinel-1A satellite data, downloaded 

previously. 

  

http://step.esa.int/main/download/
http://step.esa.int/main/download/
http://step.esa.int/main/download/
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Displaying, exploring and analyzing crisis satellite data for flood water extraction 

 

ORTHORECTIFICATION 

In this section you are going to perform the main image processing operation required prior to analysing an 

image. The most appropriate software to process Sentinel-1 imagery is the Open source software from the 

European Space Agency (ESA) called Sentinel Application Platform (SNAP) TOOLBOX. This platform 

reunites all Sentinel Toolboxes in order to offer the most complex platform for this mission. The basic 

functions include: opening a product, exploring the product components such as bands, masks and tie point 

grids. Navigation tools and pixel information functionality also represent some of the basic capabilities. 

The steps given below are only for your understanding and future use with your own dataset. 

To Open SNAP toolbox, Double Click the SNAP software shortcut on your desktop, which is given below.  

 

Import the downloaded SENTINEL-1A image  

Import the Sentinel-1A data downloaded using File – Import – SAR Sensors – SENTINEL-1 as shown 

below. 
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Select the zip file which is downloaded earlier and click on Import Product.  

S1B_IW_GRDH_1SDV_20190907T032258_20190907T032323_017926_021BD7_99E0.zip 

Please note that SNAP reads automatically .zip files (no need to unzip): 

Ortho Rectification of  SENTINEL-1A image 

The most important step after importing the data is to orthorectify the image (not optional!) 

Select Radar > Geometric > Elipsoid Correction >  Geo-Location Grid  

In I/O Parameters, select  Save as: “Geotiff-BigTIFF” and navigate to the output folder for the output.  

In Processing Parameters select “Amplitude_VV” 

Rest of the parameters keep default.  

and click Run 

 

It is the processed image obtained after the ortho-rectification (Ellipsoid correction) and speckle filtering, 

steps are given here, only for your understanding and future use. 

 In most RADAR products, one of the must do corrections is to remove speckles (salt and pepper effect). 

Again, this step will take a few minutes but it is highly recommended. Go to Radar > Speckle Filtering > 

Single Product Speckle Filter 
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In the I/O Parameters tab: 

○ Select as Source the output image of the SAR-Ellipsoid Correction 

○ Give a proper Name and Save as: “Geotiff-BigTIFF” and navigate to the output folder 

In the Processing Parameters tab : 

○ select as Source Bands Amplitude_VV 

○ choose Gamma Map Filter, the Filter Size X: 3 and Y:3  can be used. Feel free to compare 

with 5x5 and 7x7 as Filter Size. 

○ Click Run and be patient. 
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Given that the process may take some time to complete, the data is processed and given for using in the 

next exercise.  

Exercise 3.5: FLOOD WATER EXTRACTION USING SENTINEL-1 RADAR DATA 

Thresholding 

Through this process all pixels that belong to a range of pixel values corresponding to the feature you want 

to extract are assigned a value 1. All other pixels in the image are assigned a value 0. 

Identification of initial threshold value 

For this exercise you will now extract the pixel values likely corresponding to water. Before starting, 

● Open “Flood_Hazard_Analysis.mxd” in ARCMap. 

X:\ERI_Data\Module_3\Flood\Hazard\WorkSpace\ 

● Use the Identify tool on the Tools toolbar to view the attribute information of the raster image 

including the pixel values corresponding to water, which is the feature you want to extract from the 

image (make sure that the concerned raster layer is the selected layer in the Identify tool Window). 

 
What is the best threshold of pixel values to apply in order to identify and to extract those pixels 

likely corresponding to water/flood areas? 

  

_________________________________________________________________________ 

Identification of Optimal threshold value 
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Now that we have an idea of what the threshold value can be, we are going to classify water and not water 

pixels. First we are going to calculate the statistics of the raster dataset “Flood_20190907.tif 

● Bring up Arctoolbox by clicking the button 

● Go to Data management tools > Raster > Raster properties > Calculate Statistics 

● Select the raster dataset “Flood_20190907.tif,  from the following location: 

X:\ERI_Data\Module_3\Flood\Hazard\Input\Raster\ 

 

● Click OK 

 
This Calculate Statistics operation will allow us to apply classified visualization from the Symbology tab. 

  

Now we are going to create a duplicate of “Flood_20190907.tif.tif, and apply a classified visualization to 

it: 

·    Right click the image layer “Flood_20190907.tif” > Copy 

 

·    Right click on Layers and Click Paste. Another copy of  “Flood_20190907.tif””  will be added to 

the ToC. 

  

Note: This creates a copy within your mxd of the layer you are working with, NOT a copy of the actual image 

itself. 

  

Now you will work on the image copied now (which is above the original image in ToC) 

  

● Right click the image layer “Flood_20190907.tif” >Properties>Select the Symbology tab. 

● Select Classified. 

● Under Classes select 2 and click on the Classify button. 

● Under Break Values enter your threshold value as the first value and click OK 
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You now have two classes in your image, one below your threshold and one above. 

  

·   Double Click on the color box next to the class representing water and give it a color (e.g. yellow). 

·   Double Click on the color box next to the class representing everything else and select NoColor 

 
What is The Threshold you used? ________________________________ 

  

If you are not satisfied with your threshold for flood water, please change the threshold in the Break Values 

in the Classification window. 

 

Repeat this process until you are satisfied with the suitable threshold value. 

Now that you have identified a suitable threshold of pixel values corresponding to water, you can start to 

proceed with the pixel-based classification process using a raster calculator: 

  



 

122 
 

● Using the Search toolbox, open Raster Calculator 

● In the Raster Calculator tab, double click on the raster layer “Flood_20190907”” and insert the 

following mathematical expression using the most suitable identified pixel value threshold: 

   “Raster Layer” <= Threshold Value 

  

(Type the numeric value corresponding to the threshold value for water, identified by using the 

Identify tool) 

● To set the processing extent, click the Environments... >Processing Extent> AOI 

 
● Name the output raster layer as “Flood_ext_AA.tif“and save it in the output raster folder: 

 X:\ERI_Data\Module_3\Flood\Hazard\Output\Raster\ 

  

Pay attention to add also the extension (e.g. “.tif”) in the name of the output raster. 

  

● A new binary raster layer will be added in the ToC: Value 1 is assigned to the pixels values with 

similar spectral characteristics corresponding to water (as defined by the formula you typed in the 

Raster Calculator), and Value 0 is assigned to the rest of the pixels. 

● Use the Swipe Tool available from the Effect Toolbar and check your raster analysis results by 

comparing the binary raster layer with the original image. To improve your results, you will probably 

need to apply different threshold values in the Raster Calculator and repeat the above process. 
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Filtering and converting extracted flood water from raster to vector 

Filters are used to improve the quality of the raster image by eliminating spurious data or enhancing and 

smoothing features in the data. 

● From the Spatial Analyst tools>click on Neighborhood >Focal Statistics 

● Select “Flood_ext_AA.tif” as input raster and apply the filter parameters as below: 
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● Name the output raster layer as “FocalSt_Flood.tif “ and save it in the output raster folder: 

X:\ERI_Data\Module_3\Flood\Hazard\Output\Raster\ 

To convert your final flood analysis result from raster to vector: 

Search for the tool Raster to Polygon 

● Add the raster layer from the previous step (“FocalSt_Flood.tif”) and name the vector file to export 

as “Flood_ext_AA.shp” 

● Choose as output location: 

X:\ERI_Data\Module_3\Flood\Hazard\Output\Vector\ 

● Uncheck the option Simplify polygons 

 

● Add the exported vector layer to your ArcMap project. 

● Right click on “Flood_ext_AA.shp” > Edit Feature > Start Editing 

● Right click on the vector layer “Flood_ext_AA.shp” > Open Attribute Table 
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● From the Attribute Table Dialog Box, click Table Options > Select by Attributes 

● Double click on GRIDCODE and type in the following query expression: 

GRIDCODE = 0 

 

● Once all the GRIDCODE values = 0 are selected you can delete them (step 4) 

● Then in the Editor toolbar click on Editor >Save Edits>Stop Editing 

● Change the symbology of the layer as desired (It is recommended to choose Outline Color: No 

Color). 
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● To add a new attribute field to the Attribute Table, open the Attribute Table >Table Options > Add 

Field and type-in Class as name and select Text as attribute type 

● From the Attribute Table,right click on the field“Class”>Field Calculator and assign to this attribute 

field the text label “Flood Water” (type the quotation marks as well): 
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Satellite Analysis: estimated flood water extent by affected administrative units 

 

Within the immediate aftermath of a disaster, one of the most critical information needed by the 

humanitarian actors is to know spatial distribution and estimation of the water extent (in case of flooding). 

Using the Search tab, open the tool Intersect 

  

● From the Intersect Dialog Box, select the two layers you want to intersect (“Flood_ext_AA.shp” 

and “ERI_Adm2_AOI.shp”) and “NO_FID”as Join Attributes 

● Name the output layer file “Adm2_FloodWater” and choose as output location: 

 X:\ERI_Data\Module_3\Flood\Hazard\Output\Vector\ 
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The output file “Adm2_FloodWater” will be automatically added to the TOC: 

● Open the Attribute Table and you will notice that all records of the table have now the corresponding 

Admin1 and Admin2 names, which in this case are Name_1 and Name_2. 

To calculate the area (sqKm) for each polygon (record): 

  

● From the Attribute Table, clickTable Options > Add Field… Enter “Flood_sqkm” as Name and 

select Double as Field Type 

● Right click on the field “Flood_sqkm” >Calculate Geometry 

● From the Calculate Geometry Dialog Box, select the following parameters: 

● Click OK 

 

Each record of the attribute table “Adm2_FloodWater” will be filled out with the area in square kilometers. 

Using the Summarize tool in the attribute table, you can summarize the total flood water for each affected 

administrative unit. 

● Right click on Name_2 field in the attribute table, click Summarize, select the fields to be included 

in the output table (Area_sq_km and Flood_sqkm)and check the operations  



 

129 
 

    o Minimum for the field Area_sq_km (you can alternatively check Minimum, Maximum or 

Average and the result will be the same value, as this is a property coming from admin level2 

boundary and not from the intersect of admin level2 boundary and flood water) 

○ Sum for the field Flood_sqkm. 

 
 

● Name the output .dbf table as “Flood_Adm2” and choose as output location: 

X:\ERI_Data\Module_3\Flood\Hazard\Output\Vector\ 

Now you can calculate the percentage of flood water for each affected administrative unit within the AOI. 

● From the Attribute Table, click Table Options > Add Fields… Enter “Perc_Flood” as Name and 

select Double as Field Type 

● Right click on the field “Perc_Flood”> Field Calculator 

● In the Field Calculator Dialog Box, type-in the following formula to obtain the percentage of flood 
area by administrative units (Level 2): 

“(“Sum_Flood_sqkm”/ “Min_Area_sq_km”) *100” 
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3.8 Flood Exposure/Vulnerability/Risk Assessment using GIS tools   

Exercise 3.6 EXPOSURE ASSESSMENT OF ELEMENTS AT FLOOD RISK 

Introduction 

In this session, the exposure assessment of the elements at risk co-located within the flood affected area 

is assessed. 

Learning Objectives 

In this session, the participants will be able to combine the flood affected area and the elements at risk data 

and assess the exposure of the elements at risk to flood. 

1.   Understand the geographical extent of flood affected area. 

2.   Quantitative assessment of the exposure of elements at risk to flood, within the Area of Interest. 
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Data Input 

The input data used in this module is, 

Description Data path Data Type File Name 

Area of 

Interest 

\ERI_Data\Module3\Flood\Exposur

e\Input\Vector 

Vector 

(polygon) 

AOI.shp 

Flood 

Extent Area 

\ERI_Data\Module3\Flood\Exposur

e\Input\Vector 

Vector 

(polygon) 
Flood_AOI.shp 

Road 

Network 

\ERI\Module3\Flood\Exposure\Input

\Vector 

Vector 

(polyline) 

Roads_AOI.shp 

Settlement

s 

\ERI_Data\Module3\Flood\Exposur

e\Input\Vector 

  

Vector 

(point) 

Towns_AOI.shp 

Land use \ERI_Data\Module3\Flood\Exposur

e\Input\Raster 

  

Raster Landuse_AOI.tif 

Population 

(Grid) data 

\ERI_Data\Module3\Flood\Exposur

e\Input\Raster 

Raster Population_AOI.tif 

Output 

Output expected in this session is, 

●    Area of Flood Extent 

●    Length of the road types inundated due to Flood 

●    Land use categories inundated due to Flood 
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●    Settlements located in Flood area 

●    Population affected due to flood 

Assessment of elements at risk exposed to flood 

  ●     Open Flood_Exposure.mxd atX:/ERI_Data/Module3/Flood/Exposure/Workspace/ 

   ●    Overlay Flood extent and road network maps to assess the type and length of the roads 

                           within flood extent. Calculate percentage of road length exposed to floods. 

 Hint: Use Arc Tool Box Analysis Tools > Overlay > Intersect 

  ●    Length of the road types exposed to Flood 

  Type of Road and length of the road exposed to flood? 

 ________________________________________________________________________ 

 Percentage of the Road length exposed to flood? 

 ________________________________________________________________________ 

  ●    Overlay Flood extent and settlements map to assess the number of settlements located within 

                    flooded area.  Calculate percentage of settlements located within the flooded area. 

         Hint: Use Arc Tool Box Analysis Tools - Overlay – Intersect 

 ________________________________________________________________________ 

  ●    Overlay Flood extent and land use map to assess the land use categories exposed to flood. 

Hint: Use Arc Tool Box Spatial Analyst Tools > Zonal > Zonal Statistics as Table and use Statistics type 

‘SUM’ 
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Land use 

Category Code 

Land use 

Category 

Area (km2) Total_Area (km2) Percentage 

1 Trees cover 

areas 

      

2 Shrubs cover 

areas 

      

3 Grassland       

4 Cropland       

5 Vegetation 

aquatic or 

regularly 

flooded 

      

6 Sparse 

vegetation 

      

7 Bare areas       

8 Built up areas       

10 Open Water       
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●            Overlay Flood extent and Population maps to assess the population exposed to flood. 

Calculate percentage of population exposed to flood. 

  

Hint: Use Arc Tool Box Spatial Analyst Tools > Zonal > Zonal Statistics as Table and use Statistics type 

‘SUM’ 

 ________________________________________________________________________ 

 DISCUSSION 

Unlike the two previous flood management related modules, in which the accuracy of the results is highly 

dependent on data that is generated and obtained prior to when the disaster occurs, in this flood impact 

analysis the most important data related factor is to obtain remotely sensed data of the affected areas as 

soon as possible and process it quickly, effectively and with reasonable accuracy. 

Obtaining damage figures and breakdowns by administrative units is very useful for planning and 

coordinating humanitarian operations in the field. GIS allows for a very rapid estimation of the extent of 

flood water within affected areas. The timely production of these map products and data can be used by 

decision makers and humanitarian actors to prioritize and coordinate disaster response operations. 

What are the two datasets used in the flood impact analysis that can be obtained prior to when the disaster 

occurs (so we are ready to use it when needed)? 

 __________________________________________________________________________________  

 __________________________________________________________________________________  

What other sources of data could you have acquired, free of cost, to conduct a similar response 

mapping? 

  __________________________________________________________________________________  

 __________________________________________________________________________________  

Can you identify the potential problems in using Optical data? 

 __________________________________________________________________________________  

 __________________________________________________________________________________  

What are the advantages/disadvantages of using WorldPop data? 

 __________________________________________________________________________________  

 __________________________________________________________________________________  

Could you briefly explain two limitations of the methodology presented in this exercise that may affect the 

accuracy of the final output? 
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 __________________________________________________________________________________  

__________________________________________________________________________________  

When it comes to flood response mapping, are there any significant issues with the spatial resolution of the 

image being used? In other words, what – in your opinion – would have been the best spatial resolution for 

a flood of magnitude similar to the one used in this exercise? 

  __________________________________________________________________________________  

 __________________________________________________________________________________  

3.9 Flood vulnerability and risk assessment 

Flood risk is then normally expressed in terms of the following relationship: 

The assessment of flood risk requires an understanding of where the water comes from (i.e.the source), 

how and where it flows (i.e.the pathways) and the people and assets affected by it (i.e. the receptors). 

Pictorially it is shown in figure below. 

 

Source-Pathway-Receptor Model 

Source: From where the water comes? This is addressed in Flood Hazard Assessment, such as flash flood 

or riverine or coastal storm surge? 

Pathways: How and where it flows? This is also addressed in Flood Hazard Assessment, which areas are 

inundated due to flood. 

Receptors: The elements at risk such as population, infrastructure, critical facilities and livelihood which 

are exposed to floods are considered as receptors. 

 Likelihood of Flooding which is the flood hazard, explained earlier.  

Consequence of flooding is vulnerability of exposed elements at risk to flood hazard. Exposure assessment 

of elements at risk is discussed earlier and an exercise was also carried out. Now we will understand 

vulnerability of exposed elements at risk. 
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Flood vulnerability is one of the significant components in risk management and flood damage assessment. 

Vulnerability measurement is a complex process because it influenced by several environmental, 

economic, and social or even political elements in local scale. In other words vulnerability is affected by 

numerous factors such as settlements conditions, infrastructure, authority’s policy and capacities, social 

inequities, economic patterns, etc. So flood vulnerability is varied for people in diverse circumstance.  

Human systems are vulnerable to floods due to three vital aspects: Exposure, susceptibility and resilience. 

Exposure refers to people and their surroundings and every element present in flood prone area being 

exposed to the flood impacts as a subject to potential losses. Susceptibility is considered status of people, 

environment and infrastructure tendency to influence by a hazard because of fragility of community or 

ecosystem and resilience, coping and adaptation ability of a system in addressing disaster stress. Instance 

the vulnerability of urban areas is reflection of the exposure and susceptibility of the city to flood risk and 

the resilience of that region to cope and recover from the flood effects.  

An example vulnerability curve is shown here, which indicates the relationship between flood depth (m) and 

percentage of the damage for different types of buildings. 

Let us use this vulnerability curve with a building footprint map and assess the flood risk in an exercise.  

 

Exercise 3.7: Flood Risk Assessment Exercise 

 Data: Combined building footprint and flood depth map and flood vulnerability curves 
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Building footprint map and flood depth map 

 ●      Flood Depth categories in the given flood map are: 

Flood Depth (m) Color Code in the flood depth map 

1.0   

1.5   

2.0   

●      Attribute Table for Buildings with details of material, age class and cost of the building
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S.No. ID Material Number of Stories Age class 

1 3951 Timber 1 Class 1 

2 3959 Timber 2 Class 2 

3 3983 Concrete 1 Class 1 

4 3985 Concrete 2 Class 1 

5 4355 Concrete 1 Class 1 

6 4359 Masonry 2 Class 1 

7 4366 Masonry 2 Class 1 

8 4373 Masonry 1 Class 1 

9 4443 Masonry 1 Class 1 

10 4449 Concrete 2 Class 1 

●      Depth - Damage Ratio Curves 
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Methodology 

 ●       Using the building footprint map and flood depth map, find the percentage of damage to 

the buildings using the depth - damage ratio curves. 

●      Using the cost estimate of buildings, calculate the damage ($) for each type of building. 

 Result: Using the above data calculate the Damage of each type of building and fill up the table. 

ID Flood Depth (m) Damage 

Ratio 

Cost of the Building ($) Damage ($) 

3951     1000   

3959     1600   

3983     7000   

3985     10000   

4355     7000   

4359     6000   

4366    6000   

4373     3500   

4443     3500   

4449     10000   

Conclusions based on the analysis: 

What is the important information in this analysis, based on your opinion?  

 -------------------------------------------------------------------------------------------------------------------  

To develop a depth-damage curve for Nairobi/Kenya, what data you need to collect and how do you plan 

to collect? 

-------------------------------------------------------------------------------------------------------------------  


